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Background

OSIRIS (Open Source, Independent Review and Interpretation System) is a public domain quality assurance software
package that facilitates the assessment of multiplex short tandem repeat (STR) DNA profiles based on laboratory -
specific protocols. OSIRIS evaluates the raw electrophoresis data contained in an .fsa file using an independently
derived mathematically-based sizingalgorithm. OSIRIS currently supports ABI capillary analytical platforms and
numerous commercially available CODIS-compliant marker Kits.

OSIRIS searches for peaks by iteratively fitting expected parametric data signatures to the observed data, usually
achieving matches with correlations in excess of 0.999. Parametric peak locations are determined with sub-second
accuracy and transformed to base pair coordinates. Traditional sizing methods for DNA fragments usually rely on
either the local or global Southern methods to interpolate the internal lane standard (ILS) into base pair estimates.
OSIRIS departs from this approach, usinginstead the correspondence between a sample’s ILS and an associated allelic
ladder to map the time scale of the ladder into that of the sample. This integration of the ladder with the sample
permits a straightforward and accurate comparison of sample peaks with ladder locus peaks. Typically, OSIRIS-
analyzed sample peaks align within 0.1 base pair of the position within alocus. Thus, in addition to providing reliable
and accurate peak analysis, OSIRIS offers two new peak quality measures - fitlevel and sizing residual.

Based on alaboratory’s own protocols, these two measures can enhance quality metrics currently available to assess
STR DNA profiles. OSIRIS can be customized to accommodate laboratory-specific signatures including settings
sensitive to typical background noise and can include any customized naming conventions or additional internal
laboratory controls. When used in complement with other analysis methods, OSIRIS can provide a second
independent assessment of data and may alleviate the need for human review of passing profiles.

OSIRIS was initiated in response to recommendations of a multidisciplinary advisory group (the Kinship and DNA
Analysis Panel, KADAP) empanelled by the U.S. Department of Justice. KADAP was assembled to assist the New York
City Office of the Medical Examiner (OCME) and New York State Police (NYSPD) DNA laboratories in the difficult and
unprecedented legal and humanitarian challenges the World Trade Center victim identifications raised by developing
guidelines and recommendations for management of the identification process, focusing on ways to enhance the
number and quality of identifications that could be madel. Developed in collaboration with state, local and federal
forensic laboratories and NIST, the National Center for Biotechnology Information (NCBI) created OSIRIS using C++
and object oriented design to facilitate the development of add-on applications by those using the program. NCBI
performs internal quality assurance on its programs and will maintain OSIRIS at
http://www.ncbi.nlm.nih.gov/projects/SNP /osiris as part of its extensive public domain toolkit for exploring and
managing genetic data.

1 NIJ] Journal (2007) 256; Identifying Remains: Lessons Learned From 9/11
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(etting Started
Obtaining and ]nsta"ingOSlRl5

OSIRIS for Microsoft Windows XP, Vista, or Windows 7 and Apple Macintosh OSX 10.6 can be downloaded at
http://www.ncbi.nlm.nih.gov/projects/SNP /osiris. When using the version for Microsoft Windows, ifreplacing an
old OSIRIS version with a newer one, the old version must first be uninstalled before the newer version is installed.

To uninstall an older version for Windows, go to the ‘Start’ menu and select Programs -> Osiris ->
Uninstall OSIRIS. Alternatively, you can go to the Control Panel and select Add or Remove Programs,
and then scroll down to highlight Osiris and select the “Remove” button. You can now install the new version of
OSIRIS.

When using Microsoft Windows, once OSIRIS has been downloaded, open the file from Windows Explorer and follow
the installation instructions. The only installation option is selecting the location for the installation. If a previous
version of OSIRIS was removed prior to installation, the new version should be installed in the same location as the
older version in order to use the prior settings that are saved from your previous install. See Appendix B regarding
updating settings from a prior installation.

When viewing the electronic version of this guide you may navigate to sections indicated in the table of contents by
using bookmarks and by selecting hyperlinks in the document.

AQuiclcTutorial

This is a quick overview on using OSIRIS. The files shown in the examples illustrated in this guide are included with
your OSIRIS download. All of these example . fsa files were created by the Human Identity Team at the National
Institute of Standards and Technology (NIST) and are available through their STRBase website
(http://www.cstl.nist.gov/div831/strbase/interlab/MIX05.htm). It isrecommended that you use the Quick Tutorial
along with the provided NIST files to help familiarize yourself with OSIRIS. Details of OSIRIS’ features will be
described in the later chapters.

Below is an illustration of the opening window. Note the menu bar availability above the logo. The logo disappears
after a moment.
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Table Graph Tools Window Help
New Analysis... CrleN
Open Ctrl-O
Save Ctrl-5

Save As...

Export CMF File...

Export Graphic File...

Open Plot File... Ctrl+P
Open Batch File... Ctrl+B
Recent Files... Ctrl+R
Close Ctrl+W

Exit Alt+F4

After the OSIRIS logo disappears, select “New Analysis..” from the “File” pull down menu as shown below. A
dialog box labeled “Analyze Data” will appear.

Input Directory C:\Program Files\MCBI\Osiris\TestAnalysis\Identifiler\STRbaseIF || Browse... I
Output Directory C:\Users\OsirisUser My Documents\Osiris | Browse...

Create time stamped subdirectory
Operating Procedure Name [[Idmﬁﬁﬂ] v” Browse... ]
Internal Lane Standard | ABI-L1Z450 -
Minirum RFU Sample: Analysis: 130 [+ Detection: 150 = Interlocus: 150 =

Ladder: Analysis: 150 = Interlocus: 150 (5

=]

ILS: 150 =

Data @ Raw () Analyzed
| ok || cancl

When this dialog box appears, the user can enter the specificinformation and click “OK” to begin the analysis. Note
that different minimum RFU values are available for the different sample types. The drop-down menus detail the kits
and standards that OSIRIS currently recognizes. The Operating Procedure Name refers to the kitand many
other settings which are described in detail in the Laboratory Settings section. Requests for other marker sets or
controls can be sent to forensics@ncbi.nlm.nih.gov.

In the illustrated example, we are using data files created by NIST for Identifiler™ and provided with the OSIRIS
software. The NIST data files are located in a subdirectory named “TestAnalysis.” When using the Windows™
version of OSIRIS, itis a subdirectory of the directory where OSIRIS was installed. When using the Macintosh™
version, it is a subfolder in the folder containing the OSIRIS application.
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When the analysis begins, a new window appears (see below) which shows each subdirectory that will be analyzed
along with its current analysis status. If only one subdirectory is to be analyzed a new window opens upon
completion with a table containing the results of the analysis. This isillustrated below.

Directory

Start Stop

C:\Program Files\MNCBNOsiris\ TestAnalysis\Identifiler\5TRbaselF  2011-05-02 01:51:33 PM 2011-05-02 01:51:36 PM

Status
completed

Elapsed time: 00:01

[ Select Al ] | Clear Selection | |

Cancel Selection Cancel Al

| | Reanalyze Selection... |

| View Selection |

Directory Start

Stop
completed

CA\Program Files\NCED\Osiris\TestAnalysis\Identifiler\STRbaselF  2011-05-0201:51:33 PM  2011-05-02 01:51:36 PM

(o) e (22t ) oy ) ) (o) (pmmmees.. ) oo s

= | [ cvF | Files\NCBI\Osiris\TestAnalysis\identifiler\STRbaselF\Identifiler LADDER.fsa

| 'ns|channels|  pes1179-1

[ D21511-1 | o7ss201 | csFipoa

D351356-2 | THOL-2 | D135317-2

13,13

OL8.1,019.1, 14, 15

30, 30 10, 11

0122.3, 27, 0L31.1, 0L39.1 |OL8.2, 0L9.2,0L10.2 FEWEF]
0124.3, 30, 31 9,11 12,13
29,30 8,13 0,11

24.2,28,32 9,11 10, 12

10, 12

14, 15 11,11

0L143,15,16 (8,8  [0L10.2, 0L10.2, 0L10.3, OL15
s RO

17,18 8,9 10,12

8,83

7000
Time (seconds)

8000

Identifiler LADDER

Directory needs acceptance (1) Directory notices:

1. Identifiler LADDER; ILS

DEFALLT PROTOCOLS ARE OVERRIDDEN: Internal Lane Standard

Directory needs acceptance (1)

wotces | al || or || orioas || somple | chamnel J[ us | teas |
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From the table above, the user can choose which peak data to display (alleles, bps, RFU, time, peak area), view plots
containing the data, and edit the data. This is accomplished using the toolbar buttons at the top of the table window,
the pull down menu labeled “Table” on the menu bar, or by right clicking the table cell of interest to display a popup
menu. Note that when a cell is highlighted on a table, notices and detailed information appear in the bottom right
pane of the window. There isa “Preview” option on the toolbar menus that toggle the display of a plot showing the
peaks of the currently selected sample and allele. This is on by default but can be turned off in order to show more
rows in the table. As you may have noticed, there are many colors used for the table cells. These colors can be

modified and are explained in the “Grid Colors” section.

To view a more detailed graphical representation of one of the samples, click on the row of the desired sample and

select the “Graph” button on the toolbar. Following is an example.

% QSIRIS - MIXD5casel victim.plt; STRbaselF.oar; Identifiler, ABI-LIZ400

== =]

Time (seconds)

se [a] (1] overst: BRI [ I [0 ~ ]
D851179 D21511 D75820 CSFIPO i
10000 A A 27 00311 0L9.2 11
2 oL8.1 oLR.3 A, oL 12
[i4 3 Zl ] ozal A ML
" oJ 1 i ;I] 0,2
-0 1000 2000 3000 4000 5000 6000 7000 3000 5000 10000 11000 12000 13000

4| m

r @

e (@) (1) (1) (e cvove 00 I 0

D251338

Append Parameters... E
-

10000 5

a 25
4 T E
-0
8000 7000 8000 9000 10000 11000 12000 13000 L
Time (seconds) —
4| m 3 o
e (8] (1) p— T[] T - =
10000
2
& =
B -0 1000 2000 3000 4000 5000 6000 7000 8000 9000 10000 11000 12000 13000 L
Time (seconds) -
4| m 3 °
v (d (1] - T ~ x]
AMEL D5s818 FGA =
10000 A 11 A AA A
> b l OLJ[J owz
74 OL18. E
0 1
-0 1000 2000 3000 4000 5000 6000 7000 8000 5000 10000 11000 12000 13000 L
Time (seconds) -
4| m 3 °
I - T ][] > [x]
10000 o
a - &n 250
& . s 20 A 340 350 400 =
2 i I T T | A i L) h | S
-0 1000 2000 3000 4000 5000 6000 7000 8000 5000 10000 11000 12000 13000 L
Time (seconds) -
4 m v @
The image above shows a graph of the electropherograms. By default, there T
is a separate plot for each channel. The toolbar at the top of each plot as well —_—— —
. . . e aple ra ools ncow el
as the pull down menu labeled “Graph” provides many options which are — = — =
described in detail in the section titled “OSIRIS Plot Files.” Hew Analysis.. Ctri+N
Open Ctrl-0
Recently viewed files can be accessed through a dialogue window by Save Ctrl-5
selecting “Recent Files..” from the “File” pull down menu at right. An Save As...
example is shown below: Export CMF File...
Export Graphic File...
Open Plot File... Ctrl+P
Open Batch File... Ctrl+B
Recent Files... Ctrl+R
Close Ctrl+W
Exit Alt+F4
Osiris (/lser’s Cjuide [ age 8
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Recently Viewed Files @
Search:
Name Type Viewed W Modified Location
N _MIX05case1_victim.plt Plat 2011-05-0202:26:21PM  2011-05-02 02:01:42PM  C:\Users\hoffman\DocumentsOsiris \Identifiler\STRbasalF
Identifiler_20110502_140144.0br Batch 2011-05-0202:01:44PM  2011-05-02 02:01:44 PM  C:\Jsersthoffman\DocumentsOsiris \dentifiler
%STRhaseIF.oar Report 2011-05-02 02:01:44PM  2011-05-02 02:01:42 PM  C:\Usersthoffman\Documents\Osiris \Identifiler \STRbaseIF
Shaow at startup [ oK ] [ Cancel ]

This listshows up to 1000 files that have been opened by OSIRIS and can be sorted by name, type, last time viewed,
modification time, or location. To open a file, double-click on the file name or select one or more files and select the
“OK” button. You may select and view up to 10 files at a time. To search for a desired file, simply type part of the file
name inthe “Search” text box at the top of the window and the list will be updated immediately to filter out all files
that do not match the search criteria.

This concludes the quick-start tutorial. More detailed information about OSIRIS’ features can be found in subsequent
sections of this guide.

Co n{:iguration

OSIRIS has a number of parameters that can be configured to your specific protocols including laboratory settings and
the colors to display in the analysis table.

Lab Set’cings

The laboratory settings are maintained in one or more Operating =

Procedures. These Operating Procedures define a specific kit or ~ OSIRI3

marker set along with many lab settings which can be configured Eile Table Graph [Tools| Window Help _ |
in OSIRIS. OSIRIS provides many predefined Operating [ LabSettings AL |
Procedures, one for each supported marker set. These pre- Export File Settings Al+E
defined Operating Procedures cannot be modified by the user but Edit Grid Colors AlteC

are used as templates for creating new operation procedures Message Log

with laboratory specific settings. User-created Operating

Procedures can be protected from unauthorized changes by

setting the permissions of the \Osiris\site\Volumes directory where the Operating Procedure folders are stored. Ifa
systems administrator is unavailable to help with these settings please contact us at forensics@ncbi.nlm.nih.gov and
put “OSIRIS Permissions Request” in the subject line.

To configure OSIRIS, selectthe “Lab Settings” option under “Tools” on the menu bar as shown on the right. This

Thresholds, Allele Exceptions, and Acceptance/Review, which are discussed in the following sections.
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Adcl anew Operating Froceéure

To add a new Operating Procedure, clickthe

“New” button and select a predefined or OSIRIS Lab Seffings ==
preVlOuSly Created prOCedure and enter the Select Operating Procedure: [[PowsrP\exlﬁ] v][ New... ] Delete... || Rename...
3
new procedure name. The names Of the General | File Names ILumsﬂLS Thresholds ISample Thresholds IAss@nmEms I»\c(.aph’Reviewl
. . Operating Procedure Mame: [PowerPlex 16]
predefined Operating Procedures are Reagent it PowerPlex 16
enclosed in brackets and it is recommended st Update: P
that any newly created procedures not Internal Lane Standard: | Promega 115-500
follow this naming convention in order to Al User o Override
1 d . . h th Th d Protocol:
€aslly lStlngulS em. € new procedure Lothr.: Create Mew Operating Procedure @
can be saved at any time by clickingon the Notes: e el prae G e ey
“App l yn button at the bOttom Of the lab This operating procedure is provided with the OSIRIS installation. [[I_denﬁﬁler wjo ILS @250] v]
. - 3 Enter operating procedure name:
settl.ngs WInd_OW and Is al.so .saved whe"n " Custom Identifiler w/o ILS @250
closing the window by clickingon the “OK C o ) Com |
. . 0 . ance!
button. The following sections describe in

detail the available lab settings for an
Operating Procedure. If a laboratory is Going
to add positive controls or accepted off-
ladder alleles to an Operating Procedure, The user can save time by entering those, then using the new Operating
Procedure as a template for modified Operating Procedures.

Gemeral
The first ‘tab’ in the lab settings window is labeled ‘General’ and is used for basic settings. These settings include the
default internal lane standard, whether the Raw or Analyzed data from the . fsa files should be analyzed. Three

other settings, Protocol, Lot Nr., and notes do not affect the analysis, but are used for documenting the analysis and
are copied to the output files during an analysis.

i le Names
“ . ”n :
i = The “File Names” tab isused to
Select Operating Procedure: [Custnm Identifiler wjo ILS @250 v][ New... ] [ Delete... ] [ Rename... ] determlne the type Of an. fS a ﬁle by 1ts
‘ Ganaral| File Names |Lo:|.|s,|fILS Thresholds | Sample Thresholds I.ﬂsslgnments I.ﬂccept,fﬂewew| ﬁle name. The names Shown on the
File name search ariteria right include ladder, positive control,
Rmtk z negative control, and all types defined
Pasitive Control by the guidelines for creating CMF files.
MNegative Control .
Alleged Father You cannot add or delete the categories
Alleged Mother . . .
hrestee from this listdefined by the CODIS CMF
Biological Father guidelines. However, you can customize
Biological Mother
Biological Sibl ithi
BilogicalSbing any of the within each category to
Convicted Offend i
Gonvicted Offender match names used in your laboratory.
Deduced S t L ini 1
Deduced Suspect = At a minimum, users must specify
Elimination, Know i i 1 i
Foreni vire enough information to identify ladder,
Forensic, Unknovin positive control and negative control
uvenie
Legal 1
Maternal Relative ﬁl es.
Missing Person
Other
Paternal Relative
Population
Proficiency
Spouse | 4
Staff
Suspect, Known
Unidentified Person 2
4 »
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In the following example, OSIRIS identifies a file as a negative control ifit finds a name containing one of the character
strings in the large text box in the middle of the window shown below “Negative Control.” You can also add any
names that are commonly used by your laboratory or remove any names that you don’t want from the OSIRIS default
list by editing the list. OSIRIS comes with a number of commonly used file names for standard controls. When OSIRIS
encounters any of these strings in a file name it will automatically assign the control name to the file and check to
make sure that the control meets expectations. Inthe example below, any sample with a listed string in its file name
will be identified by OSIRIS as a negative control. It will (a) identify that a valid ILS exists for the sample, (b)
determine that primer peaks are present in the sample and (c) determine ifthere are other peaks in other channels
and notify the user if any of these conditions are violated for the criteria set for negative controls. Similarly, if the
negative control string used in your lab is NOT on the list, OSIRIS will issue a warning stating that no negative control
was found.

OSIRIS Lab Settings (=5l

Select Operating Procedure: ICusmm Identifiler wfo ILS @250 'I[ New... ] I Delete... J I Rename...

General | File Names |Locus,|"ILS Thresholds | Sample Thresholds | Assignments | Ar_ceptfReview|

File name search ariteria

|Negative Conrol d
neg -
-
ontl
cntrl
ct-
blank

4 [}

< Back Next = Lock Cancel Apply

Following are some example file names and whether or not they would be negative controls given the specifications in
the figure above.

File Name Negative Control

f00l-neg.fsa yes, contains ‘neg’

sample( - ) ctrl.fsa no (spaces within parentheses)
ctl-positive.fsa yes, although the name is misleading, it contains ‘ctl-’
NormanEvanGordon (neqg) . fsa yes

Ctrl-1.fsa yes, contains ‘ctrl-’

The user must ensure that the search criteria are not ambiguous. For example, if “ctr1-"isused to indicate a
negative control, and “positive” isused to indicate a positive control, then a file named “ctrl-positive.fsa”is
ambiguous and might produce unpredictable results. We recommend that users delete strings not used in their
laboratory to avoid having samples that inadvertently contain control name strings.

Osiris (Jsers (Guide Fagé i
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OSIRIS Lab Settings (23]

Select Operating Procedure: [Cusbom Identifiler w/fo ILS @250 V] [ New... ] [ Delete... ] [ Rename...

General | File Names |LocusﬂLS Thresholds | Sample Threshaolds I Assignments I Accept,.’Review|

File name search criteria

|Posih've Control i w

eo) -
pos

amp+

atl+

cntrl+

ct+

ext+

cntlde

4 [}

Standard Control Name
99474

Positive control filename search criteria are entered in the listin the figure above. OSIRIS can use several predefined
positive controls and user-defined positive controls to validate control allele values. The user can enter a predefined
positive control name in the “Standard Control Name” box, such as 9947a shown in the figure above, to set the
default to validate 9947a positive control values. In this case, ifany of the strings in the Positive Control list above is
in a filename, OSIRIS will designate it a positive control and validate the allele values for 9947a. Appendix A has alist
of the positive controls predefined for each Kkit.

The default can be overridden to validate a different predefined control by putting both the search string and control
name in the file name, such as “pos9948. fsa”to designate the positive as 9948 instead of 9947a in the example
above. Alternatively, “9948” could be entered in the listabove, in which case “9948. fsa” would be validated as a
9948 positive control. The default positive control can be changed to 9948 by entering that value in the “Standard
Control Name” box in the figure above. The “Standard Control Name” will display in the last column of the locus table
in the table view. User-defined custom positive controls are entered in the Assignments tab as described below. A
user-defined positive control can be set to the default positive control as described below.

Following are some example file names and whether or not they would be positive controls given the specifications in
the figure above.

File Name Positive Positive Control
Control
9947a.fsa No, doesn’t contain a string in the list above
pos9947a.fsa Yes, contains ‘pos’ 9947a (default)
Positive.fsa Yes, contains ‘pos’ 9947a (default)
pos9948.fsa Yes, contains ‘pos’ 9988
ctl-positive.fsa No, although the name contains ‘pos’, italso
contains ‘ctl-’, OSIRIS checks for negative
controls first

Osiris (/lscr’s Cjuide Fag@ 12
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L,OCUS/ILS Tl’xras!’volds
The “Locus/ILS Thresholds”section is

. . .. OSIRIS Lab Settings ==
used for setting maxima and minima for a

i Select Operating Procedure: ‘Cusmm Identifiler wjo ILS @250 | ‘ Delete... ‘ | Rename. ..
number Of dlfferent locus and ILS threShOI ds for General | File Mames || Locus/TL8 Thresholds || sample Thresholds I Assignments I Ar.cept{Rewewl
samples and ladders. As shown here, default Locus Limits for Samples

Default D851179 D21511 D75820 CSF1PO D351358 THO: ~
thresholds can be set for each value, or these e T e L
can be overridden (or set individually if there is Fractional filter (0 - 1.0) 0.2
Pullup fractional filter (0 - 1.0) 0.2

no default value) for each locus. ILS thresholds
are set by scrolling to the right all the way to the

Max. stutter threshold (0 - 1.0)
Max. plus stutter threshold (0 - 1.0)

0.15

. L Adenylation threshold (0 - 1.0) 0.3
last column in the Locus Limits for Min. heterozygote balance (0 - 1) 0s
Min. homozygote threshold (RFU) 350

Ladders/ILS table.

Fractional filter - athreshold to
eliminate allele calls and critical artifact calls
below a proportion of the highest peak in the
locus. For interlocus peaks the proportion is of
the highest peak in any of the loci in the
channel. If the fractional filter is set to 0.2, and

< T
Min. homozygote threshald units: |RFU -

Locus Limits for Ladders/ILS Limits

Default* D851179 D21511 D75820 CSF1PO

Fractional filter (0 - 1.0) 0.33
Pullup fractional filter (0 - 1.0) 0.4
Max. stutter threshold (0 - 1.0) 0.15

Adenylation threshold (0 - 1.0) 0.3333

D351358

THO1

4 1

m

the highest peak in the locusis 1000 RFU,
critical artifacts and allele peaks below 200 RFU
will not be called.

*Note: The default settings for ladder do not affect the ILS.

<Back | | Next> Lock Cancel Apply

Pull-up fractional filter - athreshold to eliminate critical artifact and allele calls for pull-up peaks below a

fraction of the highest peak in a locus. If the pull-up fractional filter is set to 0.2, and the highest peak in the locus is
1000 RFU, critical artifact and alleles will not be called for pull-up peaks below 200 RFU.

Max. Stutter threshold - the proportion below which “minus stutter” peaks will not have an allele call. Minus
stutter peaks are 4 bases smaller than the major peak in loci with a 4 base repeat and 5 bases smaller inlociwith a5
base repeat.

Max. plus Stutter threshold - the proportion below which “plus stutter” peaks will not have an allele call.
Plus stutter peaks are 4 bases larger than the major peak inloci with a 4 base repeat and 5 bases larger inloci witha 5
base repeat. This setting can be helpful for loci that have plus stutter, orincreased stutter between peaks separated by
arepeat (e.g, stutter at 31 between alleles 30 and 32) because the plus stutter and the minus stutter thresholds are
additive where they overlap (such as at the 31 peak between alleles 30 and 32).

Adenylation threshold - the proportion below which -A “adenylation peaks” or shoulders in the n-1 position

will not have a critical artifact or allele called. This setting does not affect peaks that fallin an n-1 position in the
ladder.

Min. homozygote threshold - the threshold below which a critical artifact will be triggered for a single peak in
alocus. Min. homozygote threshold should be set to a value that ensures that stochastic allele dropout will be
detected. If the homozygote threshold is not set high enough, stochastic (random) effect may make the RFU of the
second allele peak of a heterozygote fall below the detection threshold (if set, otherwise below the analysis threshold)
and hence not be detected by OSIRIS. Therefore, the laboratory should determine a homozygote threshold that is
appropriate for their process. Typically this would be approximately the detection (or analysis) threshold plus the

laboratory’s stochastic threshold.

Locus limits for ladders/ILS limits - these settings behave in essentially the same way as the sample
settings, but apply only to the ladders and ILS. Note that the “Default” settings apply only to the ladders. Scroll to the
right for the ILS settings. The default lab settings supplied in the Operating Procedures generally give robust
identification of ILS and ladders provided with mostkits. They can be modified if ladders or ILS are within normal
RFU ranges but OSIRIS does not appropriately identify peaks.

Osiris U5er’5 (:Juide
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Sample _]V‘}'H'CS}WOI(JS
The figure on the right shows the

available parameters for “Sample OSIRIS Leb Settings %

thresholds” which can be set for
samples, ladders or ILS, including the —

RFU Limits
minimum RFU for peak detection, sample | Ladder | TS
peak analysis and interlocus peaks, as :'f“"]'TTI::"'::J‘””) [y -
well as the maximum analysis RFU o RFD
threShOId' Detection Threshold (RFU)

Allow User to Override Min, RFU
Sample Limits

Select Operating Procedure: lPowerPIex 16 Custom 'H Mew... I l Delete. ., I l Rename...

| General I File Names I Locus/ILS Thresholds | Sample Thresholds | Assignments I Ac:eptfﬂewewl

The “RFU Limits” table is where

the user sets laboratory-determined value Units
: of pull ks le =] 2 ks
RFU thresholds. There is alsoa :::::ML;ZT:B::’“"’, * ==
CheCkbOX labeled “AllOW User to Max. No. of adenylation peaks per I peaks
Override Min. RFU.” Ifthis is not Max. off-ladder alleles per sample: == !
i Max. residual for allele (<0.5 bp): * 0,25 Sample/Ladder BP alignment
checked, the user cannot modify any |Max. Mo. of peaks with excessive residual: Y r peaks
Of the RFU par‘ameters Wlth eaCh Incomplete profile threshold for Reamp More/Reamp Less: *-H‘ 5000 | RFU
. . Ignore artifacts smaller than: * 75 bps
analysis and will only be able to I Total Number of Samples With Excessive Pullup
analyze the sample using the RFU |Percent of With Excessive Pullup %
L. Maximum Humber of Tri-Allelic Loci in Unmixed Sample 1
thresholds set here. When it is ; Smor s
checked, the user can modify RFU Maximum Number of Triallelic Loci
thresholds when performing a new B — % .
analysis. Note that modification of the i ber of Craters in * - 0
RFU thresholds during a new analysis Limanm s Bumbic doffsothes miatamulc
. . . . v Locus: il ber of Sample Loci with Craters
triggers anotification in the analyzed e e =
data indicating that the RFU Raised Baseline Tl for (RFU) 250
. Raised Baseline Threshold for Sample ILS Cha Is (RFU 250
thresholds were modified. 2oeC Zast ne Tuesiot S oame nels (RFV)
Minimum Height for Primer Dimer Peaks (RFU) 2000
Minimum Number of Peaks per Channel in Primer Dimer for Negative Control 2

There are two categories of Sample 2 1 .
Test for Presence of Sub-Analytic Peaks in Negative Controls

RFU Limits settings. The settings Test for Excessive Noise Above Analysi or below (unchecked)
highlighted in green in the figure Effable Fest for PucPssive Mkee
. Make Pull-up At Allele Artifact Non-Critical
affect the sample QC analysis and S
whether notifications and artifacts are Recommend Amp More On Low Homozygote x4
triggered. The settings highlighted in Select Reamp Regular (checked) Versus Reinject (unchecked) *xr
. . s . . Recommend Rework if Laser Off Scale Found *_
pink generally trigger notifications if e e T T T e 0
multiple artifacts occurin a sample or Ignore noise analysis in smoothing when above d O
aplate. These settings can be used to M e e o e e
judge the severity of sample quality <Back | [ext> | [ Lock [lox ] [cancel | [[apply

problems or problems that affect the
quality of the entire analysis batch or plate. Thus, the settings highlighted in pink can be used for DNA analysis QA.
Note that these settings do not affect triggering sample artifacts and notifications. So, if the “Max. No. of pull-
ups peaks per sample” issetto 2 and the sample has only a single pull-up peak, that peak will still trigger an
artifact and notification. If the sample has three pull-up peaks, in addition to the artifact and notification triggered by
each pull-up, the sample would also trigger a notification that the maximum number of pull-ups had been exceeded.

The three sample limitparameters inthe “Sample Limits” table marked with red stars directly affect the sample
analysis and should be set. Values marked with green stars should also be set as they affect the algorithm for the
software’s rework estimation to use more, less or the same amount of sample DNA in a reamplification. The ‘-, ‘+" and
‘r’ beside the stars indicate that those settings affect “reamp less”, “more” or “regular”/reinject recommendations. See
the discussion Appendix C. The other sample limits that are highlighted pink, but are not starred are quality
assurance measures that may indicate the quality of the entire analysis run and can be used for process analysis. They
do not affect either the analysis of the sample or the identification of sample artifacts and are therefore optional. See
the discussion in Appendix D regarding QA for further information. Please contact the OSIRIS team with suggestions

about additional parameters you feel would be useful in this program (forensics@ncbi.nlm.nih.gov).

Note that any numeric parameter (as opposed to a checkbox) that is left blank will not be tested; entering a zero sets
the value to zero.
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Max. No. of pull-up peaks per sample willtrigger a notification if the number of pull-up peaks ina
sample exceeds the limit.

Max. residual for allele (<0.5) parameter sets the maximum difference between the base pairs of the
allele peak compared to the ladder peak as a fraction of one base pair. A value of 0.25 indicates that alleles that fall
within #0.25 base pair of the comparison ladder allele center are not flagged for human review. OSIRIS typically
performs well with this value and it should be a starting point for determining a laboratory’s own setting. See the
discussion of excess residual for further information regarding this setting.

Ignore artifacts smaller than indicates that artifacts whose computed base pairs are less than this setting
should be ignored. This value should not be changed from the kit default without consideration of the smallest allele
that is known to be found. If this size is increased it can take precedence over other kit defined allele size
identification parameters. See the description of kit definitions for further information.

Incomplete profile threshold for Reamp More/Reamp Less is avalue that OSIRIS uses to differentiate

between profiles with locus dropout due to insufficient target DNA and profiles with locus dropout due to degradation
when itis estimating whether it would be better to use more or less target DNA in a reamplification. Laboratories
may have to experiment to determine an appropriate value for their process.

Maximum Number of Triallelic Loci in an Unmixed Sample affects how many loci OSIRIS will accept
in a sample without triggering a mixed sample message.

Raised Baseline Threshold for Samples (RFU) and for Sample ILS Channels (RFU)

parameters setthe threshold for raised baseline detection in the allele channels and the ILS channel respectively.
Raised baseline can result in minor peaks either not being called or appearing to have a higher RFU than they should
actually have.

Minimum Height for Primer Dimer Peaks (RFU) sets the minimum threshold for identifying primer dimer
peaks in the negative control. This threshold can be empirically determined by the laboratory. It should be set well
above the height of any pull-up peaks caused by the internal lane standard channel, but below the maximum threshold
intensity for the detection platform.

Minimum Number of Peaks per Channel in Primer Dimer for Negative Control helps to
discriminate the primer dimer peaks in the negative control. This should be set to at least two peaks.

Test for Presence of Sub-Analytic Peaks in Negative Controls will cause negative controls to be
flagged if there are peaks whose RFU fall below the analysis threshold, but whose RFU is greater than the detection
threshold. Peaks in the negative control that fall in the range between the detection and analysis thresholds may
detect low level contamination before it becomes an issue in the laboratory.

Test for Excessive Noise Above Analysis Threshold (Checked) or Below (Unchecked)
causes OSIRIS to flag samples when excessive baseline noise occurs, including below the analysis threshold (but above
detection threshold), or only when it occurs above the analysis threshold. This setting is active only if the excessive
noise test is activated (below).

Enable Test for Excessive Noise tests for excessive noise in the baseline. Excessive noise in the baseline
can result in minor peaks not being called. See the explanation of excessive noise in the artifact handling section.
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Make Pull-up at Allele Artifact Non-Critical setting determines whether “Pull-up at Allele” will be

reported as a critical (unchecked) or non-critical artifact. Typically, the Pull-up at Allele artifact occurs when actual
allele peaks in different channels comigrate. Users that wish to be notified if alleles in different channels comigrate
should uncheck this setting.

Flag Mixed Samples and Triallelic Loci causes OSIRIS to flag triallelic lociand loci with four or more
peaks. Samples with one or more loci with four or more alleles or that have a number of loci with trialleles that
exceeds the threshold set for mixed loci will be flagged as mixed samples.

Recommend Amp More on Low Homozygote causes OSIRIS to flag a sample with a homozygote peak below the
acceptable homozygote threshold to be flagged for reamplification with more DNA.

Select Reamp Regular (Checked) vs. Reinject (Unchecked) determines whether OSIRIS will flag
samples needing rework for reinjection or reamplification. The setting of this parameter will depend on whether the
laboratory process is designed with reinjection or reamplification in mind.

Recommend Rework if Laser Off Scale Found will cause OSIRIS to flag samples with off scale data for
reamplification with less DNA.

Attempt to apply Embedded Color Correction Matrix causes OSIRIS to apply the color matrix to .fsa
files where it has not already been applied (some Applied Biosystems 310 Genetic Analyzer files). These files appear
to have extreme pull-up, and will fail to analyze correctly without application of the matrix. Files without an
embedded color matrix, where the color matrix has already been applied, such as those produced by the 3100 and
higher Genetic Analyzers, will be unaffected if this parameter isset. However, if an Applied Biosystems 310 Genetic
Analyzer filehas had the color matrix applied and also has an embedded matrix analysis, it will be adversely affected
by reapplication of the matrix with this parameter.

Ignore noise analysis in smoothing when above detection threshold causes OSIRIS to detect
peaks above the detection threshold even in the presence of noise. We suggest selecting this parameter unless the
user sees an excessive number of insignificant peaks detected. This parameter should be checked if using OSIRIS with
very low analysis or detection thresholds (below 75). This parameter is probably unnecessary for analysis and
detection thresholds greater than or equal to 100 RFU.

Test for Primer Dimer Peaks in Negative Controls causes OSIRIS to perform the test for primer
peaks in negative control samples. When unchecked the test is not performed.

~ . / . / L ) )
Oe ttings that indicate sam /D/ti’// batch se verity (17113//1.‘1/ assurance me f/‘/cﬁ)

Turning these tests off does not affect the identification of sample artifacts. These tests trigger notifications that
indicate multiple artifacts in a sample or batch and can be used either for judging the severity of sample artifacts of
are for process QA, rather than identification of individual sample artifacts.

Max. No. of stutter peaks per sample willtrigger a notification if the number of stutter peaks in a sample
exceeds the limit. See the explanation of stutter in the artifact handling section.

Max. No. of adenylation peaks per sample willtrigger a notification if the number of -A peaks lacking
adenylation in a sample exceeds the limit. See the explanation of adenylation in the artifact handling section.
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Max. off-ladder alleles per sample will trigger a notification if the number of off-ladder alleles in a
sample exceeds the limit.

Maximum No. of Peaks with Excessive Residual will trigger a notification if the number of peaks ina

sample that have excessive residual exceeds the limit. See the explanation of Excessive Residual in the artifact
handling section.

Total Number of Samples with Excessive Pull-up will trigger a notification with the number of
samples in the batch with excessive pull-up.

Percent of Samples with Excessive Pull-up will trigger a notification if the percentage of samples in the
batch with excessive pull-up exceeds the limit.

Maximum Number of Homozygous loci willtrigger a notification if the number of homozygous lociin a sample
exceeds the limit.

Maximum Number of Triallelic loci willtrigger a notification if the number of triallelic lociin a sample
exceeds the limit.

Maximum Percentage of peaks with Pull-up willtrigger a notification if the percentage of peaks with pull-
up in a sample exceeds the limit.
Maximum Percentage of alleles with Excessive Residuals will trigger a notification if the

percentage of alleles in a sample exceeds the limit.

Maximum Number of craters in sample willtrigger a notification if the number of craters in a sample
exceeds the limit.

Maximum Number of Spikes in a Sample willtrigger a notification if the number of spikes in a sample
exceeds the limit.

Summary locus refers to events that occur in alocus in multiple samples in a batch.
Summary Locus: Maximum Number of Sample Loci with Craters willtrigger a notification if the
maximum number of samples in a batch that have craters at a particular locus is exceeded. For example ifthis is set to

10 and 12 of the samples in a batch have craters at THO1, OSIRIS will trigger a notification

Summary Locus..Percent of Loci with Craters will trigger a notification if the percentage of samples ina
batch that have craters ata particular locus is exceeded.
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A 1o 5
Asslanments

The “Assignments” section allows the user to override certain alleles or combination of alleles that would normally
be flagged by OSIRIS for human review. When alleles or sets of alleles are entered in these sections, OSIRIS treats
their appearance as “normal” unless they deviate from other threshold settings. The exceptions are specified
separately for each kitand there are four types of exceptions; Off-ladder alleles, Sample trialleles, Control trialleles,
and Positive controls.

OSIRIS Lab Settings (=234

Select Operating Procedure: [Custom Identifiler wfo ILS @250 v] [ MNew... ] [ Delete. .. ] [ Rename...

| General I File Mames I Locus/ILS Thresholds | Sample Thresholds | Assignments |Au:ept,|'Review|

Select Allele Assignments: | Off ladder alleles

Enter one allele per table cell

i e Sample trialleles

Positive control trialleles
Positive controls

10.1

For each section, the specific alleles can be designated for each locus. It is not necessary to put ladder alleles in the Off

ladder allele assignments. While OSIRIS will work properly, it may slow performance. The following is an example for
off-ladder alleles for D8S1179:

OSIRIS Lab Settings

Select Operating Procedure: [Custom Identifiler wyo ILS @250 v] [

| General I File Names I Locus/ILS Thresholds I Sample Thresholds | Assignments | Acce

select Allele Assignments: ’Dﬁ: ladder alleles

Enter one allele per table cell

D851179 | D21511  D75820  CSF1PO | D351358 | THO1 | D135317 | D165
L geran | 2.vic
10,1

10,2

12.1

12,2

For sample trialleles, three alleles are entered in each cell so that each cell contains an accepted triallele as shown
below.

OSIRIS Lab Settings

Select Operating Procedure: [Custom Identifiler wjo ILS @250 v] [

| General I File Mames I Locus/ILS Thresholds I Sample Thresholds | Assignments | Acce

Select Allele Assignments: [Sample trialleles
Enter three alleles per table cel
D8s1179 D21511 D7S820 CSF1PO D3513!
10, 11, 12
10, 12, 13
Osiris (/lser’s C;uiclc Fage i8
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The “Positive controls” Allele Assignments table in the Figure below allows the user to define laboratory-
specific positive controls. OSIRIS identifies laboratory-specific positive controls first by checking the file name for
values listed in the positive controls “File Name Search” column in the figure below. Specifying substrings for
two different controls in which one substring is contained in the other, may not produce the desired results. If both
Joel0 and Joel02 are inthe “File Name Search”list, Joel02 in the sample name may be matched as Joel0,
because the string Joel0 is contained within Joe102. Unfortunately, the order in which control names are stored
within OSIRIS may not be the same as the order they are listed in the test window. Therefore, for best results, choose
search strings that uniquely identify their corresponding positive controls, such as Joe10 and JoeO1.

The value entered inthe “Control Name” column will be displayed in the “+Ctr1” column of the analysis table.
When entering laboratory specific positive controls, itis probably least confusing to list the positive control search
string value in both the “File Name Search” columnofthe “Positive control” Allele Assignments table and
the “Positive Controls”listin File Names tab.

A laboratory-specific positive control can be designated as the default positive control. Todo this the user must enter
the same value in both the “File Name Search” column and the “Control Name”column. That value can then
be entered inthe “Positive Control”“Standard Control Name” boxinthe File Names tab described above.
Filenames with any of the search string values inthe “Positive Control”liston the File Names tab will be
validated for that user defined control. For example, if “K562” is entered as the “Control Name” and “File Name
Search” values below (with the appropriate alleles) and the “Standard Control Name”value onthe “Positive
Control”liston the File Names tab, a sample file named “pos. fsa” would be validated as a K562 positive control.

OSIRIS Lab Settings [5m]

Select Operating Procedure: [Custom Identifiler wjo ILS @250 vJ I MNew... J [ Delete... J [ Rename... I

| General I File Mames | Locus/ILS Thresholds I Sample Thresholds | Assignments |.ﬁ0:ept,|"P.eview|

select Allele Assignments: lPositive controls ']
Enter multiple slleles per table cell

Control Name | File Name Search D8s1179 D21511 D75820 CSF1PO D351358
Lab Positive Joell2 12, 13 29, 30 9,11 11, 12 10, 12

If a positive control has a triallelic locus, enter the three alleles in the “Positive controls”table. The
“Positive controls triallele” table does not associate the triallelic locus with a specific control, rather
applies itinregard to all positive controls. This should only be used in specialized situations.
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/\cceptam ce/Review

The “Accept/Review” section of the Lab Settings is used to determine how many people must accept data containing
notices or the number of people required to review data that has been edited. As shown below, the default is 1 person
to accept data with notices and 2 people to review data that has been edited. The default applies to each of the
categories listed except where a specific value is given to one of the categories. Please note that the number of people
needed to review edited data includes the person who is doing the initial analysis/editing, sothe example below
requires one person to accept alerts and a second person to review the editing done. The“Allow User to
Modify User Name” option allows the user to change his or her name in the “User ID” box when accepting,
reviewing, or editing data. This can be helpful in situations where a single user is evaluating or validating the
software and may want to be able to perform both editing and review as two different users. When this tick box is
cleared, the “User ID” defaults to the user’s login name and if more than one user is specified for accepting alerts or
reviewing editing, the users performing those tasks must have different user names. This enforces laboratory policies
that do not allow self-review. Ifthe “Allow automated export when analysis needs attention” check
box is checked, OSIRIS will run an automated export (such as data export for a LIMS) even if there are notices that
require acceptance and review. If check box is cleared, automated data export will not occur when there are notices.
Details about user defined file export are described in a later section.

OSIRIS Lab Settings (=23

Select Operating Procedure: lCustom Identifiler wjo ILS @250 VH Mew... ‘ I Delete... I I Rename... I

| General | File Names I LocusILS Thresholds | Sample Thresholds I Assignments |-¢\CCEI3tfREVIEW

Select the minimum number of users
Default | Locus Channel ILS | Sample Directory
Accept alerts 1

Review editing 2
[ Allow reviewer to modify user name
[ Allow automated export when analysis needs attention

<Back || Mext = Lock Cancel Apply

Please note that all data for each sample must meet these thresholds before the data can be exported in the CMF
format. Other export formats may need to meet these thresholds depending on how they are scripted and the
parameters they require. If the checkbox labeled “Allow automated export when analysis needs attention” is not
checked, then no automated user defined file export will be performed when any part of the new analysis file needs
review. Also, if this is not selected, exporting to any user defined format initiated from the “File” menu on the menu
bar does not require the user to accept alerts and review editing, but the user will be prompted with a warning.

Upon completion of the lab settings, the user must press the button labeled “OK” or “Apply” in order to save the
settings. As mentioned before, itisimportant that when OSIRIS is upgraded to a new version, the folder where itis
installed must be the same as the previous version in order to retain these settings.

When OSIRIS software is updated, the default kit Operating Procedures are also updated to reflect any changes in the
newer version. However, customized Operating Procedures are notupdated. OSIRIS retains all the Lab Settings and
other parameters associated with the message book in customized Operating Procedures so that an analysis can be
reproduced. The customized OPs are not erased when OSIRIS is uninstalled and reinstalled. As mentioned before, itis
important that when OSIRIS is upgraded to a new version, the folder where itis installed must be the same as the
previous version in order to retain these settings.

When upgrading to a new version of OSIRIS, a new version of the users’ customized Operating Procedures should be
created so that they will reflect the changes to the software rules in the message book (described in Appendix A). This
is explained in detail in Appendix B.
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(arid Colo rs

There are many colors used to display the analyzed data in a table.
These colors are used to indicate if the data in the table cell or the
entire sample has been edited, has notices, or has been disabled.

These colors can be modified as follows:

First select “Edit Grid Colors” from the “Tools” pull down menu to

show the “Edit Grid Colors” dialog window.

Edit Grid Colors

(el

Select a line in the lists below and use the
buttons to modify its colors or attributes

Colors

Mo alerts nor editing in sample

Table cell has alerts

Sample has alerts

Tahle cell has been edited

Sample has been edited

Tabhle cell has been edited and has alerts
Sample has been edited and has alerts

Foreground Color; _]
Background Color; :]

Attributes

Reverse

Attributes when approval or review is needed

Attrbufes when edited

| Bold Ttailic

||

[ Ok, ][ Cancel ]

” Reverse ]

-

Osiris (/lscr’s Cjuide
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~ OSIRIS

File Table Graph Window Help
Lab Settings Alt+L |
Export File Settings Alt+E
Edit Grid Calors Alt+C

Message Log

The image on the left shows the default colors and attributes for
the data in the table. To modify these colors, simply click on the
color that you want to modify. The buttons below each table are
updated to reflect the current selection and you can make
modifications. If you click on one of the “color” buttons below the
top list, a color dialog will appear and allow you to change the
color. The “Reverse”button adjacent to the color buttons will
swap the foreground and background colors. The “Attributes”
table allows selection of attributes for table cells that need
approval and table cells that have been edited. The attributes are
bold, italic, and reverse. “Reverse” is used to reverse the
foreground and background colors and is available only for cells
that need approval because colors can be selected separately for
cells that have been edited. All modifications are instantly reflected
in the color and attribute tables and when the “OK” button is
pressed; all analysis windows are updated to reflect these changes.
Please note: The color settings are on a per-user basis and each
user can set his or her preferences.
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Analysis

When an analysis is performed, one or more input folders containing .fsa files are analyzed and the results are
written to a new output folder for each .fsa folder. The output of the analysis consists of data containing alleles,
artifacts, peak area, and smoothed electropherogram data. These data can be viewed in OSIRIS in the form of a table
with peak information and graphical plots of the smoothed and raw electropherogram data. The tabular data can be
exported to a CODIS Common Message Format (CMF) 3.2 file and the graphical data can be exported to a Portable
Network Graphics (PNG) file which can then be imported into various applications including most word processing,
spreadsheet, and presentation graphics programs or displayed on a web site. There isalso an option to create user
defined export files using the XSLT language as described in detail in Appendix E. and Export Setup Tutorial

To begin an analysis, open the “Analyze Data” dialog window by selecting “New Analysis..” from the “File”
pull down menu as shown below:

~ OSIRIS
Table Graph Tools Window Help
New Analysis... Ctrl+N
Open Ctrl-O \
Save Ctrl-5
Save As...
Export CMF File...
Export Graphic File...
Open Plot File... Ctrl+P
Open Batch File... Ctrl+B Analyze Data =
Recent Files... Ctrl+R Input Directary C:\Program Files\WCEI\Osiris\TestAnalysis \Tdentifiler [ Browse... |
Llose Curl=W Output Directary C:\Users\OsirisUser\DocumentsOsiris m
Exit Alt-F4 Operating Procedure Name |[IdEﬂﬁﬁ|El'] 'l | Browse... |
Internal Lane Standard |ABI-L12400 - |
Minimum RFU Sample: Analysiz: 150 Detection: 150 Interlocus: 150 =

AR |4
MRS

Ladder: Analysis: 150 Interlocus: 150

=

Is: 150

Data @) Raw Analyzed

[ook || Cancel |

Following is a description of the parameters used for analyzing data:

Input Directory. Thisis the directory or folder which contains either .fsa files or contains subdirectories that
have .fsa filesto be analyzed. OSIRIS will begin looking in the specified directory and traverse all subdirectories
searching for .fsafiles to be analyzed. Each directory that contains one or more .fsa files will be analyzed.

Output Directory. Thisis the directory or folder that will contain the output files of the analysis. A subdirectory
with the same name as the input directory will be created and if more than one input directory containing . fsa filesis
found, the output directory will contain the same hierarchy as the input directory tree. Each analysis will create
several output files. OSIRIS will allow the user to view report and plot files, whose filenames have the extension of
.oar and .plt, respectively. The report (.oar) file contains the tabular data for an entire directory and there isone
plot (.p1t)file for each sample. There are also various text files in the output directory with either the .txt extension
for viewing in a text editor, or tab delimited (.tab) files which are better viewed with a spreadsheet program. The
plot (.p1t)files have the same name as their corresponding .fsa input files except for the file name extension. After
editing, saving creates an edited report file(.oer). All other output files begin with the name of the output folder or
directory, with some containing a suffix before the file name extension.
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Create time stamped subdirectory. If this checkbox isselected, OSIRIS will create a new subdirectory in the
output directory that is time and date stamped, which prevents an analysis from being overwritten on reanalysis.

Operating Procedure Name. Select an Operating Procedure that contains the kit or marker setthat was used to
produce the data being analyzed. To see detailed information for the Operating Procedures, selectthe “Browse”
button where you can also choose the desired Operating Procedure in the resulting dialog window.

Minimum RFU. Select the minimum RFU for samples, ILS, ladder data, and interlocus peaks. The default values are
obtained from the lab settings. If the lab settings are specified to not allow the user to override these parameters,
then user input to these fields is disabled.

ILS. Select the appropriate internal lane standard for your data. Thislist is updated from the typing kit information
when the Operating Procedure is selected. If the selected Operating Procedure does not allow the user to override the
ILS, then this pull down menu is disabled.

Data. Select whether to obtain the raw or analyzed data from the . fsa files. If “Analyzed” is selected and there isno
analyzed data in the . f£sa file(s), the results will indicate this condition. If the selected Operating Procedure does not
allow the user to override the setting, then this selection is disabled.

When the “OK” button is pressed, the analysis begins and a new window appears with the status of the analyses as
shown below.

= Running Analysis EI@
Directory Start Stop Status
C\Program Files\MCEI\Osiris\TestAnalysis\Identifiler\STRbaselF | 2011-05-02 03:38:01 PM running

Elapsed time: 00:01

Select All Clear Selection

i
b
i
[ %]
i
m
3

ction Cancel Al Reanalyze Selection... View Selection

This window shows a list of each directory being analyzed; however because we selected a single directory our
example shows only one item. The status column shows one of the following: pending, canceled, running, failed, or
completed. If the status is pending or running, it can be canceled by selecting one or more rows and pressing the
‘Cancel Selection’button. If the status is‘failed’ or ‘completed’ the tabular and graphical data (.oar file) can be
viewed either by double-clicking the item or selecting one or more items and pressing the “View Selection”
button. In the lower right corner of the window is a button labeled “Details.” When pressed, the details of the
selected analyses are displayed or hidden at the bottom of the window. Once the analysis is complete, the information
is stored in a filein the output directory. This file is automatically named beginning with the name of the folder
followed by the date and time and finally with the file extension .obr for OSIRIS Batch Report. This file can be viewed
later to show the details and/or open the tabular (.oar and .oer) files. To retrieve an .obr file, select “Open
Batch File..”or “Recent Files..” from the “File” pull down menu on the menu bar.
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OSIRISReport Files

The OSIRIS report files, also known as analysis files, contain information about the peaks found in the
electropherogram data including alleles, peak area, RFU, base pairs, mean peak time, artifacts, and alerts of potential
problems. The file extension for the report files created by OSIRIS is.oar for “OSIRIS Analysis Report.” The data in
these files can be edited and saved with the file extension of .oer for “OSIRIS Edited Report.” To open areport file,
select “Open” from the “File” pull down menu on the menu bar and search for the desired file. To open a recently
viewed file, select “Recent Files..” from the “File” pull down menu. This will display a dialog window with up to
1000 recently viewed OSIRIS files of all types including report files. When a report file is opened, a window appears
with split panes containing a table or spreadsheet in the top pane, optionally a graph in the middle, and alert info in
the bottom. The borders between the panes can be moved by clicking and dragging with the mouse.

= OSIRIS - STRbaselF.oar; Identifiler, ABI-LIZ450 = e ===
[ Graph ] [ Preview ] [ History ] = [ Parameters... ] Displary: [AJIeIes v] Osiris\TestAnalysis\Identifiler\STRbaseIF\MIX05casel_victim.fsa
IS | Channels D851179-1 D21511-1 D75820-1 CSF1PO-1| D351358-2 | THO1-2 D135317-2

1. Identifiler LADDER

2. Positive Control* [ 13, 13 30, 30 10, 11 10, 12 14, 15 8,9.3
3. Negative Control v

+.vmoscase_vieom* [ 0151, 09.1, 14,15 [01225, 27,0311, 0039.1 (018, 019: o102 [PRD

5. MIXDScase2_victim* [ 0124.3, 30, 31 g, 11 12, 13 15, 16 s,10 BB
6. MIXOScase3_victim* [

29, 30 8, 13 10, 11 17, 18 8,9 10, 12
7. MIX05cased_victim* 24.2, 28,32 9,11 10, 12 15, 16 93,93 (13,13
4 [o T = r
L
2000 — 135 160 —+
] s
B =
% 1000 3
0 L l
0 1000 2000 3000 4000 5000 6000 7000 3000 2000 10000 11000 12000 13000 1401
Time (seconds) -
q [ [T v @
MIX05casel_wvictim “ | Notices All ][ Dir ][ Dir Locus ” Sample ][ Channel ][ 1S ][ Locus
Sample needs acceptance (1 MIX05case 1_victim notices: -
1LS needs acceptance (1 SAMPLE MAY BE A MIXTURE
Channel needs acceptance (1) RECOMMEND REAMP LESS (OSIRIS - EXPORT)
D851179 needs acceptance (1 NUMBER. OF PULLUPS IN SAMPLE EXCEEDS THRESHOLD: 17 (MAX = 2)
D21511 needs acceptance (1 CORE OL ALLELE: RECOMMEND RERUN SAMPLE
D75820 needs acceptance (1 | | ONE OR MORE PEAKS HAVE LASER OFF-SCALE 3z
D351358 needs acceptance (1 AT LEAST ONE CHANNEL TN SAMPLE HAS RAISED BASELINE i
THO1 needs acceptance (1) NUMBER OF CRATER PEAKS EXCEEDS THRESHOLD: 9 (MAX = 0)
D135317 needs acceptance (1)
D165538 needs acceptance (1) Sample needs acceptance (1)
0251338 needs acceptance (1)
D 195433 needs acceptance (1) 15 channel notices:
VWA needs acceptance (1 CHANMEL PEAKS HAVE CRITICAL ARTIFACTS AT LOCATION(S): 249 IL5-Ref
TPOX needs acceptance (1) o
D18551 needs acceptance (1 . -
AMEL needs acceptance (1) S

Analgsis KcPortTablc

The output of our example analysis is shown above. Each row contains data for one sample. The first column contains
an “x” ifany part of the sample needs attention and a check mark (v') otherwise. The second column contains an
exclamation point (!) ifthere are any alerts related to the Internal Lane Standard and is blank if there are no alerts.
The third column contains the numbers of all channels that have channel level alerts. All other columns except for the
rightmost column are used for locus information with a column for each locus. The locus column headings consist of
the locus name, a hyphen followed by the channel number, and if there are any locus level directory messages, an
asterisk (*) is also displayed. The order of the columns is by channel and then location or time of peaks within the
channel. The vertical lines separating each column are black where two adjacent columns represent loci in different
channels and grey otherwise. The rightmost column contains the name of the kit positive or custom positive control.
The default color and attribute scheme for the table cellsis as follows:
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White background, black text

Yellow background, red text

Pale yellow background, black text

Black italic text or ~, blue background

Black text, light blue background

Red italic text, blue background

Grey text with a lighter grey background.

Bold Text with the foreground and

background colors swapped

The entire sample has no alerts.
The cell has one or more alerts.

The cell has no alerts, but the sample has one or more alerts.
The sample may or may not have been edited elsewhere.

The data in the cell has been edited.

The selected cell has not been edited, but the sample has been
edited elsewhere

The data in the cell has been edited and it has one or more
alerts.

The sample has been disabled and will therefore be excluded if
a CMF file is created. Disabled samples can also be re-analyzed.

The cell needs attention, either alerts need to be reviewed
or the editing needs approval.

As mentioned in the “Grid Colors” section, this color schema can be modified on a per-user basis.

USing Table Ce”s to Display InFo rmation

Clicking on various cells in the table displays different information in the preview graph and the two panes at the

bottom. When the table has the keyboard focus, the user can use the keyboard arrow keys move quickly from cell to

cell.

The effect of clicking on a cell in the following columns:

Locus Displays the zoomed locus in the preview graph (if activated) and the shows the sample’s notices and peak

information below.

= OSIRIS - STRbaselF.ozr: Identifiler, ABI-LIZ450 =N EcR (|
[ereph | [ previen_] (=] History (- [ Parameters... | Display: [aldes =] Osiris\TestAnalysis\Identifiler\STRbaseIF\MIX05case2_victim.fsa
1S | Channels D851179-1 D21511-1 D75820-1 CSFIPO-1| D351358-2 | THO1-2 D135317-2
1. Identifiler LADDER
2. Positive Control* |l 13, 13 30,30 10, 11 10, 12 14, 15 8,9.3
3. Negative Control
PR e = | ! 12,34 O+ cin: 14 45 [01223,27,01311, 0L39.1 |0L8.2, 019.2, 0L10.2 [ERER 0L10.2, 0110.2, OL10.
5. MIX05case2_victim* [l a 1,8 Jo 243,30, 31 9,11 12,13 15, 16 [s,10 BHB
6. MDX0Scase3_victim* [B] 3 29, 30 8, 13 10, 11 17, 18 8,9 10, 12
7. MIX0Scased_victim* [ 12,13 24.2,28,32 9,11 10, 12 15, 16 93,93 (13,13
4 »
A
DE51179
13
11
4000
2
z L
14 =
2000
]
1300 1500 1600 1700 1300 1300 2000 2100 2200 2300 2400 2500
Time (seconds) -
4 n 3 .J
Peak 1 | Peak 2 Notices Al ][ Dir ][ Dir Locus ][ Sample “ Channel “ s ][ Locus
Allele 11 14 MIX05case2_victim notices: -
BPS 139 151 SAMPLE MAY BE A MIXTURE
Off Ladder RECOMMEND REAMP LESS (OSIRIS - EXPORT)
" e [ 0 NUMBER OF PULLUPS TN SAMPLE EXCEEDS THRESHOLD: 3 (MAX = 2)
omozygote CORE OL ALLELE: RECOMMEND RERUN SAMPLE
RFU 4537 4985 ONE OR MORE PEAKS HAVE LASER OFF-SCALE
Time 1661] 1932.42 AT LEAST ONE CHANNEL IN SAMPLE HAS RAISED BASELINE
el s NUMBER OF CRATER PEAKS EXCEEDS THRESHOLD: 1 (MAX = 0)
Fit 1.0000  1.0000 Sample needs acceptance (1)
Allele Peak
Artifact Peak
Critical O O i
7 )
.. - . >
Osxrls (/lscr’s C;ulde fag@ 2
&
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Sample name, “x”,“v"”, or “+Ctrl” Displays all the channels for the entire profile in the preview graph, a summary of
the sample’s notices in the lower right panel, and Acceptance and Review links with the required number in
parentheses in the lower left panel.

= OSIRIS - STRbaselF.car; Identifiler, ABI-LIZ450 =R ==
) (ot [Parametman ] eper: (s~ [0 ] oeetressanatys Y etz
1S Channels D851179-1 D21511-1 D75820-1 CSF1PO-1  D351358-2 | THO1-2 D138317-2

1. Identifiler LADDER
2. Positive Control* |
3. Hegative Control

13, 13 30,30 10, 11 i0, 12 14,15 CAR 11, 11

0L24.3, 30,31 9,11 2,13 [1516 10 BN

29, 30 8,13 10, 11 17, 18 8,9 10, 12

24.2,28,32 9,11 10, 12 15, 16 9.3,9.3 (13,13

« m ] v

m

R S

= | il

0
1000 2000 3000 4000 5000 5000 7000 5000 5000 10000 11000 12000 13000  140C
Time (seconds) L
« . r @
MIXD5case2_victim motices a1 |[ o ][ oirteas J[ semple ][ chamel J[ ns [ tews
Sample needs scceptance (1 MIXDScase2_victim notices: -
Channel needs acceptance (1) e E AT AT
D21511 needs acceptance (1 RECOMMEND REAMP LESS (OSIRIS - EXPORT) =
It needs acceptance (1 MUMEER. OF PULLUPS IN SAMPLE EXCEEDS THRESHOLD: 3 (MAX = 2)
VA needs seceptance (1 CORE OL ALLELE: RECOMMEND RERUN SAMPLE
AMEL needs acceptance (1 ONE OR MORE PEAKS HAVE LASER OFF-SCALE

AT LEAST ONE CHANNEL IN SAMPLE HAS RAISED BASELINE
NUMBER. OF CRATER PEAKS EXCEEDS THRESHOLD: 1 (MAX = 0)

Sample needs acceptance (1)

Channel 1 notices:
CHANNEL PEAKS HAVE CRITICAL ARTIFACTS AT LOCATION(S): 188 ILSRef

< b

ILS Displays the ILS in the preview graph, a summary of the sample’s notices in the lower right panel, and
Acceptance and Review links with the needed count in parentheses in the lower left panel.

Channels Displays only the channels for which there are notices in the preview graph, unless there are none, in

which case it displays all channels. It displays a summary of the sample’s notices in the right hand notices box and
Acceptance and Review links with the needed count in parentheses.

Plot Preview Graph and Graph Menu

The preview graph displays a wide range of oonire

sample information that is instrumental in | Peskabel repeats

sample review. The preview graph can be = 5 L artfact marker

turned on and off either through the table . e I
menu or by clicking the preview button on =

the toolbar. As described above, clickingor | = Analysis threshold

selecting various table cells will show i /

different aspects of the plot (_iatzfl in the ke sl sacandeor greatr ascury

Sample's DESI179 collto soom the preview LT @ W w w w w w = g
graph to display that locus, as shown in the Preview graph

figures on the right. The preview graph can — "

be set to display information helpful in el ot

sample review, including the raw and o0 i i éi‘i‘f‘iéijm

analyzed peak data, various peak labels, - / Ti??;ef ms

analysis and ILS thresholds (if different), ) S

artifact markers, ILS peak positions and the | s» —

comparison ladder allele peaks. Hovering —-—-——'

the cursor over peak labels and artifact ’

markers will display a hover box with peak -

information. e e W

Preview graph with unlabeled ladder peaks
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Plot preview graph options can be found either on the “graph” menu or on the context menu that pops up when the
preview plot with a right-click of the mouse.

Following is a description of each option in the menu:

Data. This option allows the user to display raw plot data, analyzed plot data, and/or the comparison ladder alleles.
The comparison ladder allele peaks can be helpful in evaluating migration issues, microvariants and other off-ladder
peaks.

Channel. Allows the user to select one or more overlaid channel plots in order to evaluate peak alignment in
different channels in the event of cross-channel artifacts such as pull-up or spikes. To see the plots as stacked plots,
view the sample plot in the graph window as described in the “OSIRIS Plot Files” section.

Show ILS. Display or hide the ILS marker position lines.

Show Minimum RFU. Display or hide the analysis threshold lines. If the ILS analysis threshold differs from that of
the sample, and the ILS and any other channel and displayed, both thresholds will show. OSIRIS does not display the
detection threshold.

Labels. Displays or hides different sample peak allele labels including: Alleles, BPS, RFU, Time and Peak Area. When
peak labels are visible, hovering the mouse cursor over the label will display detailed allele information.

Artifacts. Allows the user to choose whether and which artifact labels to display. When either Critical or All are
selected, artifacts are marked with an “A”. The options are None, All and Critical. Critical artifacts should be visible
during editing, because these are artifacts that trigger notices requiring human intervention. As with the allele labels,
hovering the mouse cursor over an artifact label will display detailed artifact information. Hovering over artifact
labels shows different information than hovering over allele labels.

Show ladder labels. Allows the user to display or hide the ladder allele labels when the comparison ladder is
displayed.

Max. ladder peak labels. This option allows the user to select the maximum number of ladder labels to
display when the comparison ladder is displayed. Choosing a reasonable number, such as between 20 and 30 can
prevent the display from becoming visually too noisy and confusing. When the user zooms out and the number of
ladder peaks exceeds the maximum, the ladder labels automatically disappear. When the user zooms in again, they
reappear.

Tablc Toolbarand Menu (E_c]iting}

The toolbar at the top of the Table view window along with the “Table” pull down menu on the menu bar at the top
of the OSIRIS window and the context (right click) menu have the following options: Graph, Preview, Edit, History,
Sort, Parameters, Display and CMF. The menu also has items for accepting alerts, reviewing editing,
disabling/enabling sample, and showing/hiding the toolbar.

The text box on the right side of the toolbar displays the original location and name of the ABI . £sa file used to create
the analysis data in the highlighted row or cell of the table. This cannot be modified, but ifthe name is too long to be

displayed in its entirety, the user can select the text box and move the cursor in order to expose the beginning or end
of the file name.

Following is a description of each option in the toolbar and in the “Table” menu:

Graph button or Display Graph. This option will open a plot or graphic window with the electropherogram

data of the selected sample. This is a separate window not to be confused with the plot preview below the table. If the
selected cellis in alocus column, the plot(s) will be zoomed to the area of that locus; otherwise the entire plot will be
shown, excluding primer peak data. The plot window will display one plot for each channel unless the Shift key is
pressed. If the Shift key is pressed only one plot will be displayed. This is discussed in further detail in the next
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section, “OSIRIS Plot Files.” Double clicking any cell will display the graph, zoomed to the area of the locus. Single
clicking a cell displays the locus in the preview graph below the table.

Preview button. This option will show or hide a plot panel immediately below the table to show the peaks of the
currently selected sample and locus. This plotis automatically updated when the user selects a different table cell.

Edit button,or Edit Alleles, Notices, and Notes. This option allows the user to edit notices and
notes relevant to the selected cell. If the selected cell isin a locus column, the alleles and in some cases artifacts can
also be edited. The label on the pull down menu item or context (right click) menu is“Edit Locus Name” for alocus
column where the actual locus name is shown, and “Edit Notices and Notes” forthe Channel or ILS columns. If
asample, ILS or channel is selected, hyperlinks display in the lower left notification area that will also allow the user

to access the Edit Alerts window. Following is an example of the window displayed when selecting this option from
the ILS or channel columns.

Edit Alerts for MIX05case3_victim

=X

{| ILS Notices | Channel Noﬁces|

Enabled | Alert

DO NOT REWORK SAMPLE (AMALYST - EXPORT)
REAMP SAMPLE REGULAR (AMALYST - EXPORT)
REAMP SAMPLE LESS (ANALYST - EXPORT)
REAMP SAMPLE MORE (ANALYST - EXPORT)
REIMIECT SAMPLE (AMALYST - EXPORT)
REEXTRACT SAMPLE - SWAB (ANALYST - EXPORT)
REEXTRACT SAMPLE - BLOOD (AMALYST - EXPORT)

HEO000O0000OO

m

AT LEAST OME CHANMEL IM SAMPLE HAS EXCESSIVE NOISE: PEAKS MAY BE UNREPORTED
AT LEAST OME CHANMEL IM SAMPLE HAS RAISED BASELINE

Fl

Enter additional notes

Sample Review, Acceptance, and Notes

User ID: |Osirisbser

oK.

Cancel

The user can edit, enable, or disable any Directory, Sample, ILS, or Channel notices on each tab. Entering notes helps

explain the action taken for the follow-on reviewer. Following is an example of editing locus or allele peaks:
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Allele Peak 0 OJ
Artifact Peak O
Critical O

1 1

Edit Alleles for D351358 on MIX05casel _victim
Peak1 Peak2 Peak3 | Peak4 | Peaks

Allele 13.2 14.3 15.0 15.0
BPS 118.597 124.010 124.679 124.946
Off Ladder yes yes

Homozygote D |:| I:‘ I:‘
RFU 2813 2921 5889 7578
Time 1241.38| 1358.69 1373.32| 1379.21
Peak Area 14583.8 35824.7 71976.3

Fit 0.9976 0.9988 0.9962| 0.9946

B8
Enabled | Alert
15. OFF LADDER ALLELE(S) DETECTED: 14.3
125.21 CRITICAL LEVEL MESSAGES AT ALLELE(S): 15, 16
THREE ALLELES WERE IDENTIFIED
D LOCUS HAS PEAK(S) WITH LASER OFF-SCALE AT ALLELE(S): 15, 16
687 UNEXPECTED PEAK(S) IN SAMPLE LOCUS: 118 ILS-Ref
1385.1 LOCUS CONTAINS CRATER(S) AT ESTIMATED ALLELE(S): 15, 16
87883,
0.894
O

. »

Review, Acceptance, and Notes

Enter additional notes

4

User ID: |Osirislser
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The table above shows a column for each peak found in the selected locus, D3S1358 in this example. The first four
rows, Allele, BPS, Off-ladder, and Homozygote, can be edited if the peak is an allele. The allele value can be edited to a
numeric value, but not to a non-numeric value, i.e., “12.1” will work but “Artifact” and “PU” will not. The bottom three
rows, Allele Peak, Artifact Peak, and Critical can be modified to determine if the peak is an Allele, an Artifact, or both
and also, for artifacts whether or not they are critical. Whether or not an artifact is critical determines how itis
displayed in the plot window which is covered in more detail in the Artifact Handling section. If a peak isnot
designated as an allele its details are not displayed in the Analysis window and ifitis neither an allele nor an artifact,
its details are not acknowledged in the Graph window. The allele notices can also be disabled or edited in the same
manner as the sample, ILS, and channel notices by simply selecting the “Notices” tab at the top of the window. Also,
as with the sample, ILS, and channel notices, itis encouraged to enter notes describing all changes being made to the
locus peaks and notices.

Edit Directory Notices. This issimilarto “Edit Notices and Notes” from the channel or ILS columns, except
the tab labeled “Directory Notices” is selected when the dialog window appears.

Accept Alerts. This menu option enables the user to accept alerts or notices for the selected directory, locus,
sample level notices, ILS notices, and/or channel notices.

= 0SRIS
File Graph Tools Window Help
[T Display Graph
Hide Preview
Edit Directory Notices...
Edit DIS1358...
Accept Alerts r D351358 Alt+A
Review Editing ’ Sample
Disable Sample Alt=X 1Ls
Disable/Enable Multiple. AleeD Channels

Reanalyze Disabled.. Directory

History »
Sort 3
Parameters..

Display »
Export CMF File.

Hide Toolbar

When accepting directory, sample, channel, or ILS level notices, a window appears which displays the alerts and the
user’s login name and allows the user to accept the notices, edit the notices, or cancel. This is necessary if one or more
users must accept notices as indicated in the Lab Settings. Once the required number is obtained itis reflected in the
table view by the color of the cell or the removal of an asterisk (*) after the sample name for sample level notices.
Following is an illustration:

Accept Sample Notices @
Accept Sample Notices for MI(05casel_victim
Enabled Alert
DO NOT REVWORK SAMPLE (AMALYST - EXPORT)
REAMP SAMPLE REGULAR (ANALYST - EXPORT)
REAMP SAMPLE LESS (AMALYST - EXPORT)
REAMP SAMPLE MORE (AMALYST - EXPORT)
REIMIECT SAMPLE (AMALYST - EXPORT)
REEXTRACT SAMPLE - SWAB (AMALYST - EXPORT)
REEXTRACT SAMPLE - BLOOD {AMALYST - EXPORT)

SAMPLE MAY BE A MIXTURE

RECOMMEND REAMP LESS (OSIRIS - EXPORT)

NUMBER OF PULLUPS TN SAMPLE EXCEEDS THRESHOLD: 17 (MAX = J)
CORE OL ALLELE: RECOMMEMND RERUN SAMPLE

ONE OR MORE PEAKS HAVE LASER OFF-SCALE

AT LEAST ONE CHAMMEL IN SAMPLE HAS RAISED BASELINE

NUMBER. OF CRATER. PEAKS EXCEEDS THRESHOLD: 3 (MAX = 0)

] 8 0 o o

Accepted by: OsirisUser Accept Edit Cancel

Window to accept sample notices. This is the same layout for ILS notices. For channel
notices, an additional column appears with the channel number.

If the user disables or edits any of the notices for a particular level (locus, sample ILS, etc.), the sample will then
require review as opposed to acceptance. This will be reflected in the sample acceptance links displayed in the lower
left window (when the sample, ILS or channel is selected) which will automatically change from ‘needs acceptance” to
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“needs review” links. The user can choose to “Accept” notices at the Directory, Channel, Sample, etc. levels without
disabling notices, including “Artifact” and “Critical” status Allele level notices. This will be reflected in the
acceptability of the sample; however the color and font in the table will reflect that notices still exist.

(=X

Accept Alleles for DE51179 on MIX05casel _victim
Peak 1 | Peak 2 Peak3 Peak4

Allele 8.1 9.1 14 15
BPS 128 132 151 155
Off Ladder yes yes

Homozygote | [ ] [l [l [l
RFU 4116 3325 10406 9154
Time 1378.79| 1467.29 1895 1983.72
Peak Area 44313.1) 21751.5 152460 130513
Fit 0.9909 0.9955 0.9990 0.5933
Allele Peak
Artifact Peak
Critical [ |

Enabled | Alert

OFF LADDER. ALLELE(S) DETECTED: 8.1, 9.1

CRITICAL LEVEL MESSAGES AT ALLELE(S): 8.1, 9.1

MORE THAM THREE ALLELES WERE IDEMTIFIED

LOCUS HAS PEAK(S) WITH LASER OFF-SCALE AT ALLELE(S): 14, 15

Accepted by:  OsirisUser

Accept E Cancel

Window used to accept locus notices.

When accepting locus notices, a window like the example above appears with all of the locus information. The user
can enter a user ID and accept the notices, edit the locus, or cancel. Since it is possible that many loci will need
approval, accelerator keys can be used for this operation (Microsoft Windows only). Alt+A will open the window to
accept the selected locus, and when the window like the one above appears, pressing Alt+A again will accept it. After
this, the user can use the arrow keys to select another locus in the analysis table.

Review Editing. Thisallowsa
subsequent user to review editing of the
directory, locus, sample, channel, or ILS

Approve Editing for DBS1179 on MIX0Scasel_victim

<< < | |original ¥ =

Peak 1| Peak 2 Peak3 Peak4

Enabled |Alert

i ele . . s :8.1,9.
alerts performed by the firstuser. The = T CRITCAL S/ s T ALELE s 855
. . . . er es es MORE THAN THREE ALLELES WERE IDENTIFIED
number Of reVleWerS needed ls lndlcated ‘I::lll:i::gota YD VD D D LOCUS HAS PEAK(S) WITH LASER OFF-SCALE AT ALLEI
in the Lab Settings and includes the first wu e e
s . e e
person to perform the editing. This can it a9 0ssss os0 v

v
also be accessed through the sample e
Critical O O

review links displayed in the lower left
window when the sample, ILS, or channel
isselected. The window that appears for

« i b

Review, Acceptance, and Notes

Current

reviewing the locus contains the history of [~ eskileeska pesks vesks T e R A T 15T | et e ametey Do
the alerts, notices and notes for the locus L e e O e
aS Shown On the r‘ight. :Fo:lvlozvgota |:4|“6 Dﬂzs qus I:Ql154 LOCUS HAS PEAK(S) WITH LASER OFF-SCALE AT ALLEl | Removed o ladder alleles

Time 1378.79 | 1467.29 1895 1983.72

Peak Area 44313.1 217515 152460 130613
When reviewing or approving editing, the |(uwrs L O O O
user can approve, edit, or cancel. This is s R
necessary if one or more users must
review editing as indicated in the Lab ! b
Settings. Once the required number is s (domone ) et ) [cones ]

obtained it is reflected in the color of the

cell or the removal of an asterisk (*) after the sample name for sample level editing. When approving editing for the

sample, channels, or ILS, only the notices and notes appear with the history. When acceptance and review is complete
at all levels (Sample, Channel, Locus, ILS, etc.), the red cell containing an “X” changes to a green checkmark. In order to
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export to a CMF file, all of the samples that are not disabled must not need attention and the directory level notices
must be accepted or reviewed.

Disable (or Enable) Sample. This allowsthe user do disable a sample or (re) enable a sample. The reason to
disable a sample is that the analysis was not successful and itis desired reanalyze only a few samples or ifyou wish to
exclude it from a CMF file.

Disable/Enable Multiple. This displaysa window, as shown Disable Samples (=
on the right, which allows the user to disable or (re) enable multiple Disable Samples
samples.

History. The history button or menu item is used to display the
data as it was saved in previous versions of the file. The history
button or menu item displays a menu with a listof dates the file was
saved along with “Original”and “Current.” The “Original”
selection shows the original data obtained from the analysis before
anything was edited. The “Current” selection shows the data with S
any editing performed since the last time it was saved. For the

analysis window the first item in the history menu is one of the following depending on the selected cell or row: View
Sample Notices, View ILS Notices,View Channel Notices,orAllele Edit History. This
selection is enabled only for data that have a history of being edited and it displays a dialog window containing details
of the editing performed and saved on the selected cell or sample.

The buttons adjacent to the “History” button are used to display state of the file at the previous and next times the
data was saved. If any historic time other than “Current” is selected, the selected time is displayed in the window
title.

Sort. Thisallows the user to sort the samples by sample name or severity. When sorting by sample name, the
ladders and controls are shown at the top followed by each sample in alphabetical order. When sorting by severity,
the actual severity is determined by the number of notices for the sample. A sample with no alleles found may be
shown at the bottom even though it may be more severe than a sample with many alleles found, but also many
notices.

Parameters.. This button or menu item displays a Analysis Parameters (==
popup window Containing the paramEterS used for this Input Directory C:/Program Files MNCBIOsiris TestAnalysis Identifiler [STRbaseIF
analysis. The input directory and Output directory are Output Directory C: /Users (QsirisUser [Documents (Osiris Tdentifiler baselF
. . Kit Name Identifiler
hyperlinked to enable the user to view the contents. The Operating Procedure Name [Identifler]
Operating Procedure is hyperlinked to a dialog window Internal Lane Standard  ABI-LIZ450
. . : Minimum RFU Sample: Analysis: 150, Detection: 150, Interlocus: 150
that shows all of the settllngs at the time t}.le analysis was P S
performed. An example is shown on the right. ns: 1w
Data Raw
D.:l.splay. This pull down -or submenu allow§ the user to
display Alleles, BPS, RFU, Time, or Peak Area in the table
cells.

CMF or Export CMF File.. This option allows the user to export the data ina CODIS 3.2 Common Message Format

(CMF) file. Please note that if the analysis file has been edited, it must first be saved before exporting a CMF file. Ifit
has not been saved, a window will appear to prompt the user to decide whether to save the file or cancel. When
exporting a CMF file, a dialog appears with many options for the file and each sample. Followingis an example:
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Export CMF File = |-
Source Lab: OsirisLab
Destination Lab: OsirisLab
Submit User 1Dz OsirisUser
Batch ID: 20110502_162336
Default Specmen Type: | Other - |
Spedmens

Exclude Type Partial | Missing Loci | Source ID Case ID Sample Name Comments
4. MIX05casel_victim D [Default] D MIX05casel_victim
5. MIX05case2_victim D [Default] D MIX05case2_victim
6. MIX0S5case3_victim D [Default] D MIX05case3_victim
7. MDWScased_victim | [ | [Defaui] 1 MIX05cased _victim
File Name
C:\Users\OsirisUserDocuments\Osiris\Identifiler \STRbaseIF\STRbaselF.cmf Browse...
V| View File Location

ook | Cancel ‘ ‘ Finish Later |

The Source Lab, Destination Lab, Submit User ID, and Default Specimen Type are automatically saved and used as the
default for subsequent CMF files. Please note that the Submit User ID may not be editable depending on this option in
the lab settings at the time of analysis. The Batch ID is automatically created using the current date and time. The
table contains arow for each sample. The exclude column allows the user to exclude one or more samples. The
“Type” isa drop down list of all available types of specimens. If “[Default]”is selected, then the selection for
“Default Specimen Type”above isused. “Partial”isselected if one or more loci do not have any allele calls.
This can be modified by the user. “Missing Loci” shows a listof all loci that do not have any alleles. “Source ID”
and “Case ID”can be edited by the user. “Sample name” isby default the name of the sample taken from the name
of the original ABI . fsa file and used in the analysis file. It is also used as the row label on the left, but for purposes of
writing a CMF file, it can be edited in the “Sample name” column. The “Comments” column allows the user to enter
any desired comments for any sample to be included in the CMF file.

Below the table, the user can specify the name of the output file, which by default is the name and location of the
Analysis file except with the file extension changed to . cmf. To find another location or change the file name, the user
can select the “Browse...” button to choose from a file dialog window. There is a checkbox labeled “View File
Location.” Ifthis is selected, a window with the location of the CMF file is displayed after the file is created in order
to access the file from the computer’s operating or window system. The CMF file is created when the user presses the
“OK” button. If the user presses the button labeled “Finish Later” then this window will close and return the user
to the Analysis window but all changes will be saved and restored if “CMF” is selected again. This is useful if the user
needs to examine the data again before exporting the CMF file. If the “Cancel” button is pressed, all changes will be
discarded.

OSIRISFlot FFiles

The OSIRIS Plot Files have an extension of .plt and unlike the report files, they are not intended to be edited. The
plot files are used to display a graph of the raw, analyzed, and ladder electrophoresis data with labels for alleles,
artifacts, and loci. The curve data and locus location are always obtained from the plot file, but the peak and artifact
information can be obtained from either the plot fileor a corresponding analysis file. If an analysis file is used to
obtain the alleles and artifacts, then any changes made by the user are also reflected in the plot window. There are
several ways to open a plot file. To open a plot file as a standalone file (without its corresponding analysis file) select
“Open Plot File..”or “Recent Files..” fromthe “File” pull down menu on the menu bar and select the
desired file. A plot file can also be opened from its corresponding report file by selecting the desired sample in the
table of the Analysis window and selecting “Graph” from the tool bar if visible or by selecting “Display Graph”
from the context menu (right click) or the “Table” pull down menu on the menu bar. It can also be opened by
double-clicking on a cell or row label within a sample. If a graph window is opened from the analysis window, the
peak data displayed in the graph window will be obtained from the report file and the names of the plot and report
files will both appear in the title bar at the top of the window. When the graph is opened from the analysis window,
the actual data initially displayed depends on the selected cell in the sample and whether or not the shift key isheld
down. It isimportant to understand that opening a . plt plot file as a standalone will not show editing and history. If
the plot file has not been moved out the of the folder containing its associated report files, the editing and user
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changes may be viewed by selecting the “Talble” button to open the analysis file. Followingis a table illustrating
different ways to open a graph window from the analysis file.

With
Type of Cell Shift key
Selected Pressed
Locus One plot for each channel. Zoomed One plot zoomed to selected locus
to selected locus and scrolled to
ensure visibility of channel
containing locus
ILS, Channels, One plot for each channel. Zoomed  All channels in a single plot. Zoomed
+Ctrl, %, v, or out but excluding primer peak data out but excluding primer peak data

entire sample

Different methods of opening a graph window from the analysis window

= cars =
File Table Graph Tools Window Help

= OSIRIS - STRbaselF.oer; Identifiler, ABI-LIZ450 =2 =

Graph Edit | [« History Sort | [ Parameters... | Display: [Alleles ~| [eMF | \User_3 i \ _victim.fsa

1S | Channels | D8S1179-1 D21511-1 D75820-1 CSFIPO-1| D351358-2 | THO1-2 D13§317-2 D165539-2

018.2,01.9.2, 0L10.2 FEREEY (8,8 0110.2, 0110.2, 01103, 0115.1 01102, OL11.

72 OSIRIS - MIX05casel _victim.ph; STRbaselF oer; Identifiler, ABI-LIZ450 [ &)

Dotar [[A] (R ] [L] [Teble |  chemne: [N (8 (=20 B0 5F1 (15 [RAU]  Lobes: [Aldles ] [Ladder | Artfacts: [eritial v (][] [ResetAxes | [Muit ¥

DE51179 D21511

1. Identifiler LADDER
2. Positive Control*®

10, 12
3. Negative Control
4. Mxoscase1_victim* [EIIIPPEL RIS
5. MIX05case2_victim* [
6. s_victim* [

0L14.3, 15, 16

7. MIX05cased_victim* [

11000
14

10000
10000

3000

RFU

5000

0

A
1600 o223

«

Peak 1| Pel 6000 a
Allele 15.1
BPS 151
Off Ladder | yes 5000
Homozygote | [ ]
RFU 10406
Time 1895 19 4000
Peak Area 152480
Fit 0.88%0
Allelepeak | [] 3000 A
Artifact Peak o1

N A VLV G 'Y NV,

1600 1800 2000 2200 2400 2600 2800 3000 3200 3400 3600 3300 4000 4200 440,
Time (seconds)

RFU

4

MIX0Scasel_victim

D21S11 is selected for MIX05casel_victim, shift key is pressed while pressing
the Graph button resulting in a single plot of channel 1 zoomed to D21S11.

The preceding image shows the result of selecting the D21S11 locus of sample MIX05casel_victim, holding down the
Shift key and pressing the “Graph” button. The plot was zoomed to the selected locus and because the Shift key
was pressed, only one plot was displayed. Note that two allele peaks displayed in the table are not shown in the plot,
22.3 (OL) and 39.1 (OL). Thisis because they are outside the range of the ladder for D21S11. These peaks can be
shown by zooming out, a topic that will be discussed in detail later in this section.

Grapi‘l Too"aar

The toolbar at the top of each plot along with the “Graph” pull down menu on the menu bar have the following
options: Data, Channels, Sync, ILS, RFU, Labels, Artifacts, History, Reset Axes, Multiple, Append, Parameters, and Close
Plot (X). The menu also has items for showing or hiding the toolbars and scrollbars in the plot and the last selection of
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these items is used as the default when opening subsequent plot files. Following is a description of each option in the
toolbar and menu:

Data: Raw, Analyzed, Ladder, Table. The toggle buttons labeled 2, R,and L are used to show or hide
the curves for Analyzed Data, Raw Data, and Ladder Data. If the shift key is pressed while selecting one of these
options the selection will immediately be used for all plots in the window. The “Table” button shows the window
with the report data and selects the row for the sample in the graph window. If there is no report file opened for this
graph window, the user is prompted to select a report file or cancel. If a report file is selected, itis used for labeling
alleles and artifacts. The “Graph” pull down menu has a submenu for each plotand each of these submenus has a
“Data” submenu with entries for these options. In addition to this, the “Graph” pull down menu has a menu item
labeled “Show Table” which performs the same action as the “Table” button.

Channel. There isa toggle button for each channel labeled with the channel name and its background color
corresponding to the color of the channel and its plot. If the shift key is down when pressing a “Channel” button,
then only that channel will be displayed with all other channels hidden.

Sync or Synchronize Axes. This toggle button or checked menu item is used to synchronize multiple plots when
domain and/or range are modified. If this is selected, every time the view is changed, the view is updated on all other
plots where this option is also selected. If the shift key is down when selecting this, the setting is updated in all
plots in the window.

ILS or Show ILS. This option shows or hides vertical lines to indicate where the peaks are in the ILS channel. The
color of the lines corresponds to the color of the ILS channel. If the shift key is pressed while selecting this option,
the setting will be shown in all plots in the window.

RFU or Show Minimum RFU. This option shows or hides one or more horizontal lines to indicate the location of the
minimum RFU selected when the analysis was performed. The actual lines are for the minimum sample and/or ILS
RFU depending on the selected channels. Ifthe shiftkey ispressed while selecting this option, the setting will be
set in all plots in the window.

Labels. This option determines how the alleles will be labeled. The options are None, Alleles, BPS, RFU, or Time. If
the shift key is pressed while selecting this option, the selection will be used in all plots in the window. The labels

appear above the allele peaks and when the cursor is placed over a label, a box appears with detailed information
about the allele. The loci are also displayed at the top of the plot unless “None” is selected. When the user clicks on a

locus label, the plot is zoomed to the range and domain of that locus and if “Sync” is selected, all other synchronized
plots are zoomed also.

Artifacts. Thisoption determines which artifacts are labeled: All, Critical, or None. The artifacts are labeled with
an “A” and when the cursor is placed over the label a box appears with detailed information about the artifact. If the
shift key is pressed while selecting this option, the setting will be shown in all plots in the window.

H, History. The history button or menu item is used to display the data as it was saved in previous versions of the
report file. This is similar to the history option in the report window, except the button islabeled with the letter “H” in
order to save space. The button or menu item displays a (sub)menu with a listof dates the file was saved along with
“Original”and “Current.” The “Original” selection shows the original data obtained from the analysis before
anything was edited. The “Current” selection shows the data with all editing (if any) performed since the last time it
was saved. If the filehas been saved many times, some of the dates may appear in the menu with a selection for
“More..” which opens a dialog window that allows the user to select from all save points. If there is no report file
opened for this plot window, the user is prompted to select a report file or cancel.

Reset Axes, Show Primer Peaks. When “Reset Axes” is selected, the plot is zoomed out to show all peak
data. Ifthe Shift key is pressed when selecting “Reset Axes” from the toolbar or if “Show Primer Peaks”is
selected from the menu, then the plotis zoomed out to show all data including the primer peaks at the beginning of
the plot.

Multiple, Multiple Plots, Remove Other Plots. When “Multiple”or “Multiple Plots”is

selected, a separate plot is displayed for each channel. Ifthe Shift key is pressed when selecting “Multiple” on the
toolbar orif “Remove Other Plots”isselected from the menu, then all but the selected plot are removed.

Append. This option appends a new identical plot below the plot whose menu or toolbar is performing the action.
The maximum number of plots is equal to the number of channels.
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Parameters.. This button or menu item displays a popup window T —— =

containing the parameters used for this analysis. The input and output loput Drectory C:Progan Fles OBt el et STEb sl
directories are hyperlinked to enable the user to view the contents. The K e

Operating Procedure is hyperlinked to a dialog window that shows all of memalianesiondard sz

the settings at the time the analysis was performed. When the Analysis Ladder: Analys: 150

Parameters popup is displayed this from a plot in the Graph window it pata -

also displays the ladder file associated with the analysis of that sample. tadderrie Imm

An example is shown on the right.
X, Remove Plot. Thisoption removes the specified plot from the window. If this “X” button is pressed on the
toolbar while the Shift key is pressed, all other plots are removed in the same manner as pressing the “Multiple”
button with the Shift key down or selecting “Remove Other Plots”from the menu. This feature is disabled
when only one plot is displayed.

Arrows. If the toolbar istoo narrow to accommodate all of its items, then an arrow is displayed at each end and the
user can click on the arrow to shift the items on or off the visible portion of the toolbar as shown below.

"~ OSIRIS - MIX05casel victim.plt; STRbaselF.oer; Identifiler, ABI-LIZ450 =N =Rt

‘ Data: E E Channel: _I E Labels: |Alleles h Artifacts: |Critical = >

Toolbar is shifted to the left, left arrow is grey and disabled

L:: OSIRIS - MIX05casel_victim.plt; STRbaselF.oer; Identifiler, ABI-LIZ450 (= |
m}j cnerne: (] [ 521 B [ N rrr— actiocts: [Gibeal 7] ) [(Rectrs) (rities] ((Rem) [P [ X
Toolbar is shifted to the right, right arrow is grey and disabled

Rcsizing Flots

=~ OSRIS
When viewing multiple graphs in a single window, the height of each graph may be too e T (GET] Toos it
small. The height of each plot can either be fixed to fitinto the window or resized to be 2 .
larger with a new scrollbar added to scroll through the larger plots. This option is chosen s X
by selecting “Resizable Plots”in the “Graph” pull down menu as shown on the Paameter.
right i
When this is selected, a sash or horizontal bar is displayed between each plot. The plot E:W?‘E‘”b
can then be resized by clickingand dragging this bar to the desired size as shown below. kNN
After dragging the sash, each T e T e T
plot is resized to the selected o —
height and a scroll bar is shown = .
on the right if the total height -
exceeds the height of the © o
window. 200

1600 1800 2000 2200 2900 2600 2800 3000 3200 3400

. Time (seconds)
Once the plots have been resized, |
the new sizebecomes the default :

Labek: [Aldes__~

size when opening a new graph

window. Please note: On the

version of OSIRIS for the 40 o | ek or sash between piots
Macintosh, there is no black line .

or marker displayed when 0

dragging to resize the plot and it |, oo om T e ‘m - £

does not appear to work until ot () () [ [rotie ] cvere 51 1 0 I s (] (i) ettt (i) D)) (i) shiae) [ o |

the mouse button is released. i
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E_xport Graphic Filc

The plots currently being viewed can be exported to a portable

: ' ! : Export PNG Graphic Fil

network graphics (PNG) file. A PNG file can be used with most mjzo — )
software that will display or print graphic files including web e —g——
browsers, word processing programs, spreadsheets, and Usage
presentation graphics. This is done by selecting “Export @sween ()Print  WidthxHeight 1024 X 768
Graphic File”from the “File” menu on the menu bar. A ey —

ncnes
dialog window will appear as shown on the rlght The title is tings\OsirisUser My Documents\Osiris\STRbaselF \MIX05case4_victim| cantimeters
text displayed above the plots. Usage is selected to create a View File Location
graphics fileto be used by either on a screen or printed. The [ o J[ conced J[ Ppreview |

resolutions are 72 and 300 dots per inch (dpi) respectively. If
you plan to include the graphic in a word processing file, itis recommended that “Print” is selected and that the
units are either “Inches” or “Centimeters” are chosen with the approximate size selected. For applications that are
primarily viewed on a screen, for example, spreadsheets or presentation graphics, “Screen” isrecommended. The
file name and “Browse” buttons are used for choosing where to save the file and the checkbox labeled “View File
Location” when checked, will open a window displaying the folder containing the graphic file after itis saved. The
“Preview” button allows the user to preview the graphic file before saving it. This is useful because itis likely that
adjustments will be needed before saving a graphic file.

Vichor‘t and Zooming

When viewing the graph, itis often desirable to zoom and/or pan to a particular locus or peak and there are several
ways to do this.

Reset Axes. To view all of the allele peaks, select “Reset Axes” on the toolbar or from the plot submenu on the
“Graph” pull down menu. This viewport will not include the primer peaks near the origin of the plot. To include
primer peaks, hold down the Shift key when selecting the “Reset Axes” button on the toolbar or select “Show
Primer Peaks” from the plot submenu on the “Table” pull down menu.

Zoom To Locus. To zoom to a particular locus, simply click on the locus name at the top of the plot. This will zoom
the X-Axis to the range specified by the ladder and the Y-axis to accommodate all data in that range. This will not

«_n

display adjacent interlocus peaks, but they can be viewed by clicking on the plotand pressing “a” on the keyboard.
Keyboard options for setting the viewport are described later.

Shift Axes. To shiftthe X or Y axes, move the cursor over the axis labels and when the cursor changes to two arrows
(up and down for the Y-axis, left and right for the X-axis) simply clickand drag the mouse in the direction of the
desired data to shift the range.

Keyboard Control. There are several keys that will change the viewport of the plot. Before using the keyboard itis
important to first click on the plotin order to selectit for receiving the keyboard input. The alphabetic keys must be
lowercase. The keystrokes are as follows:

Arrow/Cursor Keys - Pan by a small amount in the direction indicated by the arrow.
Page Up/Page Down - Pan the Y-Axis up or down by alarge amount.
Home - Center the plotaround the origin (0,0).

a - Zoom out X-Axis (decrease peak width)

d - Zoom in X-Axis (increase peak width)

x — Zoom out Y-Axis (decrease peak size)

w - Zoom in Y-Axis (increase peak size)

e - Zoom in both axes

z - Zoom out both axes

s — Zoom out to show all data including primer peaks

q - Zoom out X-Axis, zoom in Y-Axis

c - Zoom in X-Axis, zoom out Y-Axis

Keyboard zooming centers on the middle of the plot displayed, so that it may be necessary to shift the axes as
described above after keyboard zooming to center the desired data in the viewable part of the graph.

Osiris U5er’5 (:Juide Fagﬁ 36
Version2.02Rev.1



Zoom to Rectangle. Another method of zooming is to clickand drag the mouse in order to draw a rectangle around
the desired region. Following is an illustration:

= RIS - MUDScased victi pi: STRbaselF.ous: lenifier, ASI-I2450
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Click on a corner of the desired rectangular region and drag the mouse to see an outline.
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After the mouse button is released, the plot is zoomed to the selected region.

If the results are not as desired, simply reset the axes as described above and try again.
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Export SctuP Tutorial

Following are two tutorials with instructions on implementing the two XSLT export file types supplied with OSIRIS.
This section does not cover all of the details of the XSLT export feature, nor does it require any knowledge of the XSLT
language. If you wish to modify these two XSLT files, it is strongly recommended that you first copy them to another
location because they may otherwise be replaced if a newer version of OSIRIS is installed.

ngportingfjpreaa‘siwects

This tutorial contains instructions to implement the export of a tab delimited file containing the sample allele
information from an OSIRIS analysis file that can later be opened from a spreadsheet application. Firstselect Export
File Settings from the Tools menu on the menu bar. When the popup window appears, select the button
labeled “New...” and a dialog window will appear, prompting the user to choose an XSLT file. In the Windows version,
find the “Config” folder in the OSIRIS installation and select the file: “tab.xs1.” In the Macintosh version, find the
“OsirisXSL” folder in the directory containing the OSIRIS application and choose “tab.xsl1.”

Under the heading “Export File Description”enter the

Create Export File Type @

word “Spreadsheet” (or change to desired name). This veL Fic
description is used in the menu option that will be created in the C:\Users|OsrisUser \nstallationDirectory\Osiis \Configtzb. ! Browse...
File menu on the menu bar and will follow the word “Export,” et le descrption

. . . . . . preadshes
i.e., there will be an option in the File menu displayed as e ———
“Export Spreadsheet.” For the file name extensions, enter tab, b, i
“« » . | Allove user to override

tab, txt” (or other suchas x1s)to specify that the output Def it output Fil locatian
files will have an extension of “tab” or “. txt.” The box labeled [Remember Last Location] ~ | Browse...

“Allow user to override”isused to determine if the user
can use a file extension other than that specified above when
exporting a file. For the default output file location, the user can
select “[Same as Analysis File], [Remember Last

Location], orenter the full path of the default folder where the
exported file should be saved. For now, select “ [Remember S [ coneel ]

Last Location].” Clickthe “Next >” button and the
following will appear.

The selected XSL file, tab.xsl, has two top-level parameters named
“OL,” and “UseChannelNr.” They are configured as follows:
ﬁfﬂ% PSS Select “OL” on the left, and under “Parameter description”
peechamety P o enter “Indicate off-ladder alleles”and select
“checkbox” for the “Parameter type.” Two text boxes will
appear. For the first one labeled “Parameter value if
checked,” enter the number 1. For the other, labeled,
“Parameter value if unchecked” enter the number 0.

Create Export File Type @

Select “UseChannelNr” from the liston the left. Under
“Parameter description” enter “Indicate channel numbers
in column headings.” For parameter type, as above, select
“checkbox” and once again the two text boxes will appear. Enter
[ <Back | mext> | [ concel | 1 and 0 as described above.

Click the “Next >” button. At the top of the window is a checkbox. Make sure that itis not checked and click on the
“Finish” button. The dialogfor “Export File Types” willstillappear. Clickon “Done.” This export type has
now been implemented. When an analysis file is open, this export option labeled “Export spreadsheet” will
appear onthe “File” pull down menu on the menu bar (as indicated below) or in a sub-menu labeled “Export” if
more than one export type has been implemented.
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= |0SIRIS
[File] Table Graph Tools Window Help

New Analysis... Ctrl+N
Open Ctrl-0
Save ctrl-S
Save As..

Export CMF File...

Export Graphic File...

Export spreadsheet...

Open Plot File... Ctrl+P
Open Batch File.. Cirl+B
Recent Files... Crl+R
Close CtrlsW
Exit Alt+F4

[” xtracti ng Sam p les

Next, with an analysis file displayed, select “Export Spreadsheet..” from the
“File” menu. A dialog window will appear prompting you to select the name of the

file to be exported. After that is entered, a new dialog window will appear with the
parameters as they were configured. This is shown on the right. The first two check
boxes are for the parameters and the third

checkbox labeled “View file location” Export spreadsheet (=5
is used if user wishes to open displaying the [ indicate offtadder alleles
folder containing the output file. Upon Indicate channel numbers in column headings
pressing “OK” the export file will be created. view file location

ook | Cancel

The other export type supplied with OSIRIS is the ability to export a new analysis file with only specific samples
selected by the user. For example this would allow a laboratory to create an analysis file for a report or a discovery
package that contains only samples that pertain to a specific case. It isassumed that the previous tutorial was
implemented and therefore these instructions will be brief.

First, select “Export File Settings”from the “Tools” menu on the

menu bar. When the file selection dialog appears, choose the file: ;\EOSI;LE Graply Window Help
“extractSamples.xsl.” When the next dialog window appears, enter Lab Settings AleL
“selected samples”under “Export File Description”and enter ZT:;ZI::ZHQS :‘:CE
“oer”under “File Name Extensions.” Do not check the box labeled Message Log

“Allow user to override”and for “Default Output File

Location”select “[Same as Analysis File]

ik

Select “names” under “External parameters” and under

Create Export File Type @ “« . . » “«
Parameter description” enter "Enter part or
External parameters Parameter description
e whole names of samples to export separated by
ndudeControls »
E;ngugefad%rsd Parameter typa commas.” Selected each of the other three parameters and for
3Includebisables
’ each select “checkbox” for the “Parameter type”and enter 1
and O for “Parameter value if checked”and “Parameter
value if not checked,” respectively. Use the following table
for the text to enter under “Parameter description” for each
parameter:
External parameters Parameter Description
plIncludeControls Include positive and negative controls
p2IncludelLadders Include ladder files
p3IncludeDisabled Include disabled samples
| < Back H Mext = ] | Cancel |
Click on the “Next >”" button. In the next window, make sure the

checkbox at the top this section is unchecked, and clickon the “Finish” button. Then click “Done” on the “Export
File Types” dialog window. Followingare instructions for exporting two samples from the analysis file
STRbaseIF.oar created from the tutorial section of this guide.

Open the file STRbaseIF.oar. The easiest way to find itis to select “Recent Files..” from the “File” menuy, find
itin the listand select “OK”. Next, select “Export” then “selected samples..” from the “File” menu. A dialog
window will appear prompting for a file name for the exported file. Enter a file name in the pre-selected folder and

press the “Save” button. A new dialog

window will appear as follows: Export selected samples (5w

The first two checkboxes are selected by
default because that represents the
default value for the corresponding
parameters in the XSLT file. In the text
box at the top, enter “casel, case2” for
the samples whose names contain
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View file location
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“casel” or “case2.” Next, select the checkbox labeled “View file location”and clickon the “OK” button. A
window will appear with the folder containing the new export file. If you are using the Windows ™ version of OSIRIS,
drag the new file to the OSIRIS window to view. For the Macintosh ™ version, double-click the fileto open it. The new
file should contain everything found in STRbaseIF.oar except for MIX05case3 victimand

MIX05case4 victim because they were not specified.

*Since the output files being exported are analysis files with the . oer extension, they are intended to be opened with OSIRIS and should be in the
same folder as the original analysis file because they will depend on the plot ( . p1t) files in the same folder.

OS]RlS Arti{:act H andling

OSIRIS mathematically fits curves to the raw data and then correlates those curves to peak and artifact signatures.
This is discussed in detail in the following publication: Goor RM, Forman Neall L, Hoffman D, Sherry ST, "A
Mathematical Approach to the Analysis of Multiplex DNA Profiles.” Bull Math Biol. 2010 Nov 20. [Epub ahead of print]. It
isimportant to note that while OSIRIS is extremely proficient at fitting high quality DNA profiles, OSIRIS may have
difficulty fitting or analyzing really poor quality data. In this case, OSIRIS will identify artifacts, but may not always be
able to determine which specific artifact is occurring. The following information provides a guide to the user about
how OSIRIS identifies and handles certain artifacts.

Critical artifact. Critical artifacts are conditions based on user-defined and OSIRIS software parameters that
require human intervention. The user may choose to accept, edit, or rework the sample. Loci with critical artifacts

are designated in the table as colored cells. Critical artifacts are visiblein the preview graph and Graph view (as ‘A’
markers) if they are associated with a specific peak and either ‘Critical’ or ‘A11’ Artifacts isselected. Artifact
details appear when the cursor is hovered over the “A” marker. Critical artifacts that are not associated with a specific
peak such as heterozygote imbalance and locus drop out display in the lower right hand notification pane of the Table
view.

Important: Notification of critical artifacts in a DNA profile does not necessarily indicate that data isinvalid or
unusable. The user must decide whether to accept, edit, or rework a sample profile based on laboratory protocols.

Non-critical artifact. Artifacts that are determined to not be significant based on user-defined parameters. For
example, these include peaks below various user-set thresholds such as detection, stutter, adenylation, fractional
filter, etc.; or that otherwise do not have an impact on profile quality. These artifacts do not trigger artifact notices,
therefore they do not require human intervention. By default, non-critical artifacts are not visiblein the table and are
not visiblein the preview graph. To view non-critical artifacts in the preview graph or Graph view, select “A11”
Artifacts from the menu or toolbar to mark the non-critical artifacts with an "A".

Ladder/sample matching. If more than one ladder isincluded in the analysis directory, OSIRIS compares the fit of
the ILS of each ladder to the ILS of each sample and uses the ladder with the best fit for each individual sample.
Should a ladder have critical artifacts, each associated sample will have a notice to the alert the user. Click the
Parameters button on the toolbar to view the ladder associated with a sample inthe “Analysis Parameters”
window.

Missing ILS peaks. IfILS peaks are missing, e.g. peaks below the analysis threshold, the sample analysis will fail and
trigger an “ILS Contains Too Few Peaks” artifact notice. If the ILS is marginal (ILS peak spacing fitisless than 0.999),
which can occur if there are artifact peaks in the ILS near the primer peaks, OSIRIS may analyze the sample but trigger
anotification. Allele calls in a sample with marginal ILS may not be robust and should be evaluated with care by the
user. If the ILS has artifacts that prevent its analysis, it will trigger an “ILS Could Not Be Analyzed” artifact notice. If
no ladder has a usable ILS, the analysis will fail. A failed analysis can be opened to view the issues that caused the

ladders to fail, which may allow reanalysis with parameters that will allow the ladders to analyze, such as lowering
the ILS or ladder RFU thresholds.
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Excess residual. The “Excess residual” artifact occurs when the peak residual is greater orless than the “Max.
residual for allele”value setby the user inthe lab settings. It iscaused by sample peaks not aligning exactly
with the comparison ladder peaks. The “residual” is OSIRIS’s measure of what fraction of a base pair the calculated
sample peak center isaway from the ladder allele peak center. A residual of -0.098 means the peak is shifted
98/1000s base pair to the left of the ladder allele. Positive residual indicates a shift to the right.

OSIRIS analysis typically produces very small residuals because OSIRIS fits the best ladder ILS for each sample as
described above. We suggest that the user start with the default setting of 0.25 base pair which typically does not
result in excess residual. This creates a 0.5 base pair bin centered on the ladder peak, into which the sample peak
must fall. To prevent misidentification of a microvariant, itisimportant that this setting not approach 0.5 base pair.

Spikes/Pull-up. Pull-up occurs when the color subtraction matrix is poor or when the signal intensity is outside the
linear range of the matrix. Pull-up peaks are identified by OSIRIS as either “primary pull-up” - the overly high peak
that OSIRIS estimates to be causing the artifact, and pull-up peaks caused by the primary peak. Pull-up can manifest
in a wide variety of peak heights and analysis can be difficult, particularly in cases where a pull-up coincides with a
real allele peak. The user should consider all aspects of all channels carefully ifthey intend to use allele calls produced
from peaks that have pull-up.

Since both spikes and pull-up are cross-channel artifacts, they share many characteristics that can cause OSIRIS to
alternatively identify a spike as a pull-up. It will however trigger an artifact notice in either case.

Some kits have markers with alleles in different channels that comigrate. In this case, OSIRIS will sometimes trigger a
notice that comigrating-allele peaks may be pull-up, possibly requiring human review, depending on whether the
artifact is deemed to be critical or non-critical. The priority of the “Possible Pull-up Coincides With
Allele” message can be configured by the user in the lab settings interface. There is a check box on the “Sample
Thresholds” tab of the Lab Settings window which has the description “Make Pull-up at Allele Artifact
Non-Critical.” Thissetting determines if comigrating-allele pull-ups are critical. If the check box is checked,
comigrating-allele pull-ups are deemed non-critical, otherwise they are critical. Even if comigrating-allele pull-ups are
configured to be non-critical, the occurrence of a “laser off-scale” artifact, suggesting an actual pull-up rather than
coincidental allele comigration, is still critical, ensuring human review. In any case, the user always has the option to
edit the peaks and their artifacts to make the best use of the data.

Signal saturation. This occurs when the signal intensity saturates the CCD camera and the recorded signal intensity
cannot increase further. This can cause a number of different artifacts. This will trigger a “Laser Off-Scale”
artifact, which is used in calculating other artifact notices.

Craters. A crater occurs when the primary peak signal is saturated and the pull-up

peaks are sohigh that the matrix subtraction causes the center of the primary peak to
pull down into avalley, as shown at right. OSIRIS tries to identify craters by finding
closely spaced peaks that could be the edge of a crater calculating the theoretical

center of the possible cratered peak and comparing it to comigrating peaks in the 10000 A
other channels. When the data matches the crater signature, it will identify the side
peaks as possible crater side peaks and will assign an estimated peak call to the
calculated theoretical crater peak, which usually lies about midway between the side 5000
peaks. While this estimated peak is usually correct, this estimated allele call should
be evaluated with care, as this is OSIRIS’s estimation of what the allele peak would

RFLU

be, not an actual allele peak. Craters trigger locus notifications and ‘A’ markers on -0

the crater peak edges and center.
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Off-ladder alleles. Alleles that are apparent microvariants, or are higher or lower than the ladder alleles at each
locus, are marked “OL” with the calculated allele call, such as OL12.1. Off-ladder alleles will trigger a critical LOCUS
artifact notice. However, if the off-ladder allele does not trigger a critical ALLELE artifact notice in addition to the off-
ladder, the peak itself will not be marked with an “A” on the sample graph.

Adenylation. (Non-critical artifact) OSIRIS will identify and filter peaks one base pair shorter than the allele (N-1)
with a peak height below the user-set adenylation threshold. -A “Adenylation peaks” above that threshold will be
called as an off-ladder allele and trigger alocus artifact notice. -A peaks that fall above the adenylation threshold can
be detected using the heterozygous peak imbalance threshold.

Interlocus peaks. Interlocus peaks fall between the defined locus boundaries and trigger a critical artifact. OSIRIS
will discriminate between interlocus pull-up peaks and genuine off-ladder interlocus peaks and trigger appropriate
notifications.

Raised baseline. Before analysis, OSIRIS assesses the baselines at the right end of the plot of each channel and
normalizes them so that they are zero. However, itis still possible for there to remain raised baselines to the left or
center of the plot. If this occurs, OSIRIS may fit curves to smaller deviations in the plot data than when the baseline is
at anormal level because OSIRIS fits the analyzed data to a baseline which is expected to be zero. This can result in
small peaks that appear larger in the analyzed data than they are in relation to the elevated baseline in the raw data,
minor peaks that are broader in the analyzed data than in the raw data, and minor analyzed data peaks that are fitted
to small deviations in the raw baseline. This does not occur to a significant extent in high quality data, and rarely is
significant enough to trigger the critical artifact notice “Channel Has Raised Baseline”. When raised baseline
artifact notices occur, it can be informative to view the raw data (if not viewed simultaneously) to evaluate the
baseline quality. When OSIRIS fits the analyzed data to the raw data, it tests each “peak” to determine whether the
curve or a straight line has a better fit. If the straight line is a better fit, the fitted line is tested to determine ifitlies
above the “Raised Baseline Threshold”, set onthe “Sample Thresholds” tab of the lab settings user interface.
There are two different values that can be set, the threshold that will apply to sample data channels and the threshold
that will apply to ILS data. If a fitted straight line exceeds its designated threshold, then a critical “Raised
Baseline” artifact will be triggered, requiring human attention. .

Excessive noise. When OSIRIS fits the analyzed data to the raw data, itis possible that a sequence of data points
cannot be fitted with acceptable accuracy as either a data peak or as a known artifact. If the sequence of data has
sufficient height, OSIRIS will trigger a critical “Excessive Noise” notification onthe channel. The notification does
not localize the excessive noise detected, so the user should evaluate the profile carefully; it can be informative to
evaluate the raw data to ensure that curves in the raw data are identified. The user can choose to test above the
analytical threshold or between the analytical and the detection thresholds, by checking a box labeled “Test for
Presence of Excessive Noise Above Analysis Threshold (checked) or below (unchecked)”.
This test, which applies to all sample channels, can be disabled on the “Sample Thresholds” tab of the lab settings user
interface by clearing the “Enable Test for Excessive Noise” checkbox.

Low copy number. OSIRIS version 2.02 should be carefully validated if a laboratory is intending to use it for
identification and quality control of peaks below approximately 50 RFU. OSIRIS 2.02 is configured to allow a Min.
Analysis Threshold setting of 5 RFU. Note that elevated baselines will have a more significant effect on peaks with low
RFU.

Peak shape. If peak shape does not fit the double-Gaussian peak signature well, it triggers an artifact notice. Peak
shape fit data can be viewed in the allele hover box, but not in the artifact hover box. Peak fitless than 0.999 may
indicate data quality issues. Critical artifacts at a specific peak will trigger a “Critical Level Messages At

Allele (s) :” notification in lower right notification pane of the Table view, in addition to the ‘A’ marker at the peak.
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Stutter. (Non-critical artifact) OSIRIS will identify and filter peaks that fit the stutter artifact signature. OSIRIS
determines whether peaks fall below stutter thresholds set by the user for both minus stutter (N-4/5) and plus stutter
(N+4/5). Both can be set as a default for all loci or individually on a per locus basis. If both the default value and a
locus value are set, the locus value will take precedence over the default. Plus stutter occurs very infrequently in most
loci. A few locihave a higher occurrence and are also subject to bracket stutter, where additive plus and minus stutter
between peaks separated by two repeats (i.e., 10, 12) result in a higher than normal stutter peak between them. The
plus stutter threshold may help to address both situations. When bracket stutter occurs, e.g., the 11 peak between 10
and 12 alleles, OSIRIS will use the sum of the plus and minus stutter peak proportions to determine whether the
bracket peak is stutter. For example, assume that the 10 allele is 1000 RFU and the 12 allele is 2000 RFU, with the
minus stutter threshold set at 0.1 (10%) and the plus stutter threshold set at 0.02 (2%). The combined plus and
minus stutter threshold to which the 11 peak would be compared would be 220 RFU ([0.1x2000]+[0.02x1000]). As
stutter is both process- and laboratory-specific, labs should determine appropriate values for their system. Stutter
peaks that fall above the stutter threshold can be detected using the heterozygous peak imbalance threshold.

Heterozygous peak imbalance. Peak height ratio that islower than the minimum heterozygote balance threshold
will trigger a “Heterozygous Imbalance Detected” artifact notice.

Heterozygous allele dropout. When a homozygote peak height falls below the user-defined minimum homozygote
peak height threshold or if there is a locus that contains a “homozygote” peak and a peak whose height is below the
analysis threshold, but above the detection threshold, then OSIRIS will trigger a “Single Peak Detected,
Height Inappropriate for Homozygote” artifact notice.
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APPcndiccs

AppcndixA. Frogram Elemcnts

OSIRIS can be thought of as having four major elements: the compiled software that does the majority of the peak
identification, curve fitting and measurements, the Message Book which applies quality assessment rules, the user
interface and Operating Procedures that include the lab settings, and kit and ladder definitions.

CLO mpi]ec! So ftware

Within OSIRIS, there isan important distinction between what is hard-coded and what is under user-control. Hard-
coded measurements include such items as determining whether a signal height is above or below the user-specified
minimum RFU. In all such threshold tests, even though hard-coded, the magnitude of the threshold itself is user-
specified.

The conditions for peak identification are quite complex, however they involve the following elements: raw data RFU
height, raw data RFU baseline level, changes in the slope of the baseline and curve fit. If the raw data rises to within
about 10% of the detection threshold, OSIRIS will look for a change in the average slope of the data. Where OSIRIS
finds a change in the slope of the raw baseline, it will begin curve fitting. Curve fitting involves comparison of the data
to a straight line and various other curves to determine the best fit. When OSIRIS has found a curve that has an
appropriate fit (>0.98) itapplies other tests, including comparison to the threshold, to determine whether to continue
analysis of the peak. The result is that OSIRIS will identify quite small peaks with fairly high accuracy. However, at
very low detection or analysis thresholds, OSIRIS will sometimes ignore small peaks because of poor fit, or identify as
small peaks deviations in the slope of the baseline because it matches an accepted fit.

When OSIRIS finds a data point above the Approximate Minimum Detection threshold (about Detection Threshold
minus 10%), it checks to determine whether the baseline is falling. Under those circumstances it continues its peak
identification algorithm. OSIRIS works from right to left on the dataset to identify peaks.

Message Bo ok

OSIRIS Version 2.0 introduced a MessageBook structure and software support to enable users to modify quality
assessment rules and customize their own, new messages. In Version 2.0x, the major focus of user control is in this
MessageBook configuration file, which is the repository for all of the new OSIRIS so-called “smart messages.”

The new smart messages for the OSIRIS program transfers the rule-based analysis from hard code to user control, at
least to an extent that is consistent with ease of use. Because typical users are not programmers, the means to modify
the smart messages must be transparent to subject matter experts without requiring computer tools expertise. We
have tried to balance user control over sample diagnostics with ease of use.

In the Message Book, we have created an XML based language for expressing most of the rules to be used in analyzing
multiplex DNA samples. The language is straightforward and broad in scope due to the liberal use of Boolean logic
expressions for making decisions about whether a condition applies, whether to report the condition, and in what
priority to apply the consequences. Smart messages are fully user-configurable. The value of being able to define new
smart messages derived from the values or the data of other smart messages, is that, using these new messages, we
are now able to build sophisticated interpretations of sample data, and we can customize the reporting of these
interpretations.
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Operating Fro cedures and Kt definitions

When performing an analysis an Operating Procedure must be selected. A pre-defined Operating Procedure for each
supported kit or marker setis provided with OSIRIS and cannot be modified, but customized Operating Procedures

are created by copying an existing Operating Procedure. Operating Procedures created by the user are placed in a
new folder whose name begins with “V” followed by the date and time of creation. An Operating Procedure consists of
four files whose names are prefixed with the folder name:

V-20110323-112549 access.txt
V-20110323-112549 LabSettings.xml
V-20110323-112549 MessageBookV4.0.xml
V-20110323-112549 StdSettings.xml

The access.txt fileisan administrative file that OSIRIS requires while processing. The LabSettings.xml file
contains the selected kitand customized settings and thresholds for the Operating Procedure. The
_MessageBookV4.0.xml fileis the message book. The StdSettings.xml file contains the kit, ladder and ILS
definitions. The Microsoft Windows ™ version of OSIRIS stores the Operating Procedures inthe site\Volumes
folder in the OSIRIS installation folder. The Macintosh version of OSIRIS stores Operating Procedures inthe Osiris-
Files/Volumes folder which is either in the same folder as the OSIRIS application (parent folder of Osiris.app)
orinthe /Libraries folder if OSIRIS isinstalled in the /Applications folder. If OSIRIS is installed in the
/BApplications folder, it may be necessary to login as administrator to set up and to change Operating Procedures.

Kit definitions
The elements of the kit definition are inthe StdSettings.xml file. See Appendix G for instructions on defining new
kits and additional information on each element.

F lements Defined:

ILS

Ladder

Positive Control allele values
Primer peaks

Minimum size setting

Alleles

Core locus

Extended locus

Interlocus

F ositive Controls Defined in Default OPcrating Procedures

Each kit has at least the kit positive control allele values defined so that the positive control profile can be validated.
Most kits have additional positive control values defined. This allows the user to select a predefined default positive
control, as determined by the Positive Control strings on the File Names tab in the Lab Settings, rather than having to
enter it as a custom Positive Control on the Assignments tab.

OSIRIS determines which samples are positive controls and which control values to use for validation by looking for
one of the positive control string names from the Positive Control strings on the File Names tab, then matching the
found string against an internal table of all the predefined and custom positive control strings. If none of the
predefined or custom positive strings are found, then OSIRIS validates using the default positive control that is
entered inthe “Standard Control Name” box of the “Positive Control” on the File Names tab of the Lab Settings.
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Controls

Kit 9947A 9948 K562 2800M | DNAOO7

Profiler Plus X

Cofiler

Identifiler

Identifiler Plus

Identifiler Less 250

R | R <] <
IR Rl el el e

Identifiler Plus Less 250

Yfiler X

PowerPlex 16 X X X

PowerPlex 1.2

PowerPlex Y X

PowerPlex 18D X X

SGM Plus X

Co re/Extendecl/] nterlocus Bounclarics

The following diagram serves to illustrate the “Core locus”, “Extended locus” and the “Interlocus” concepts. Itdoes not
reflect the actual kit definition boundaries. The core locus is bounded by the top and bottom ladder alleles as can be
seen in all three loci. The extended locus extends to the right and left of the core locus. It may overlap the adjacent
extended locus as seen to the right of D13S317 and the core of the adjacent locus as seen to the left of D16S539. The
extended locus may not extend beyond the core of an adjacent locus. The interlocus lies between the extended locus
of adjacent loci (e.g., white box between D16S539 and D2S1338) and above the top and below the bottom locus
extended loci (e.g., to the right of D251338). The interlocus area beyond the leftmost locus in the channel is bounded
by the base pair value in the user-defined “Ignore artifacts smaller than”setting inthe “Sample
Thresholds” tab of the lab settings. The interlocus area beyond the rightmost locus in the channel is bounded by the
kit-defined range of the analysis.

D16S539 D251338

Bl Core
Inter Inter
[ xiended ] locus locus

The interlocus area is analyzed by OSIRIS, to ensure that off-ladder alleles that fall outside of a defined locus cannot be
ignored. However, alleles in the interlocus area will not be called and cannot be assigned to alocus by the user.
Alleles that fall into the extended locus will be called as off-ladder alleles and can be edited. OSIRIS will call alleles
that fall into overlapping extended locus as off-ladder and where possible, assign them to the locus that makes the
most sense based on base pair residual (i.e., match to adjacent ladders), the number of alleles in the loci to the right
and left, the presence of other ambiguous alleles in the loci to the right and left and whether the ambiguous allele is
stutter or below fractional filter in one but not the other locus. Where the extended locus overlaps the core of an
adjacent locus, OSIRIS will assign a peak in the core overlap to the core locus. A peak that falls on-ladder in a core
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locus and is overlapped by the extended locus of the locus adjacent will not be marked as off-ladder (and will receive a
non-critical artifact stating it could belong to an adjacent locus). If it falls off-ladder in the core, it will be marked as
off-ladder and receive a critical artifact indicating that it could belong to an adjacent locus. In any of these cases,
when the ambiguous allele is reviewed, the user may assign it to either adjacent locus. Overlapping the extended

locus with the extended and core locus of the neighboring locus gives the user the flexibility to assign rare off-ladder
alleles to the appropriate locus. See the National Institute of Standards and Technology (NIST) STRBase website for a
list of off-ladder alleles that have been reported by users (http://www.cstl.nist.gov/div831/strbase).

Please contact us at forensics@ncbi.nlm.nih.gov for assistance with modifying kits or adding new kits to OSIRIS.

APPcndix B.U Pgradingan OPcrating Procedure to a newversion O5]R]5

To ensure that the historical conditions for analysis are preserved when OSIRIS is upgraded to a new version, the
message book, standard settings and lab settings files associated with the previous version remain associated with the
original Operating Procedure, which is not deleted when OSIRIS is uninstalled or reinstalled. This means that when
OSIRIS is upgraded, the new version’s settings and new message book rules will not be implemented in the old
Operating Procedure(s). Previous version Operating Procedures (OPs) can either be re-created or can be updated one
of two ways, either by copying the new message book file into all of the Operating Procedures that need to be updated
or by copying the lab settings fileinto a newly created Operating Procedure.

To re-create the customized Operating Procedure from one of the default templates in brackets (not a previous-
version customized Operating Procedure), in OSIRIS select Tools>Lab Settings>"New” button and select one of the
default OPs in brackets, such as [PowerPlex 16]. Give this Operating Procedure a new name so that it will be
distinguishable from the previous version of the customized Operating Procedure. Then, re-enter the lab settings.
This method is the simplest, however, it may be time consuming if many settings have been changed and many
accepted microvariant and off-ladder alleles have been entered. The other methods are alittle more complex, but
avoid re-entering many values in heavily customized Operating Procedures.

The Microsoft Windows ™ version of OSIRIS stores the customized Operating Procedures inthe site\Volumes
folder in the OSIRIS installation folder. The Macintosh version of OSIRIS stores customized Operating Procedures in
the Osiris-Files/Volumes folder which is either in the same folder as the OSIRIS application (parent folder of
Osiris.app)orinthe /Libraries folder if OSIRIS isinstalled inthe /Applications folder. If OSIRIS is
installed in the /Applications folder, it may be necessary to log in as administrator to set up new Operating
Procedures and to change existing ones.

Note: It may be helpful to create a text filein the new OP directory that has as its file name the name of the OP, such as
CofilerRev2.0.txt. This can help the user responsible for managing the OPs to identify which directory a particular OP
resides in if there are several custom OPs created.

Uninstalling the old version of OSIRIS (using the OSIRIS uninstall program) and reinstalling a new version will leave
intact the OSIRIS directory and the site subdirectory containing the old version OPs. It is recommended that users
archive a copy of OPs that they intend to modify.

T—o copy the new message bookto the oldversion of the OF

This method of updating the OP maintains the original date/time in the folder and file names. This can be automated
for all of the OPs through the use of a batch file (described below.), significantly reducing the amount of work and the
possibility of error

1. Open the old OP directory, select the old message book file and delete it or rename it. Copy the new message
book from one of the new default OP directories such as \Osiris\Config\Volumes\ID\
ID_MessageBookV4.0.xml into the old OP directory. This can be done by selecting the file, selecting
Edit>Copy, then switching to the old OP directory and selecting Edit>Paste.

2. In the old OP directory, rename the copied new message book file with the old directory’s date/time, such as:
renaming ID_MessageBookV4.0.xml to V-20110328-173646_MessageBookV4.0.xml. This can be accomplished
on a PC by selecting the file, choosing File>Rename, then selecting the prefix part of the name to be changed
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and retyping it. Alternatively, the date part of the name of one of the other filesin the old OP directory can be
highlighted (using ‘Rename’), copied and then pasted into the name of the new message book file, to save
typing and increase accuracy. Note: When renaming files, do not add the .xml extension ifthe extensions are
not showing in the filedirectory, as OSIRIS will then be unable to recognize the file if it ends in .xml.xml.

Toco Py the lab settings ofa Prcvious version OF to an uPdatecl version:

1.

N

Open the newly installed version of OSIRIS. Create a new OP in OSIRIS using the updated default OP in
brackets, by selecting Tools>Lab Settings>"New” button. Note: It may be helpful to create a text file that has
as its file name the name of the OP in the new OP directory, such as CofilerRev2.0.txt. This can help the user
responsible for managing the OPs to identify which directory the OP resides in ifthere are several custom OPs
created.

Open the new updated OP directory and delete the new lab settings file, newdate-hhmmss_LabSettings.xml
Open the old OP directory, select the old lab settings file and copy it to the new OP directory. This can be
done by Edit>Copy then switching to the new directory and selecting Edit>Paste.

In the old directory, modify the old lab settings file by adding “BAK” anywhere in the file name. If the user
wants the old OP to appear in the pick list, this can be changed back at the end of this procedure. Either
archiving the directory containing the file to a new location or leaving “BAK” in the name of the old lab
settings fileprevents the old OP from showing in the OP pick list.

In the new OP directory, rename the copied old lab settings file with the new directory’s date/time, such as:
V-20110323-112549_Lab Settings.xml >V-20110328-173646_LabSettings.xml. This can be accomplished on a
PC by selecting the name choosing File>Rename, then selecting the date/time part of the name to be changed
and retyping it. Alternatively, the date part of the name of one of the other files in the new directory can be
highlighted in the same fashion, copied and then pasted into the name of the old file, to save typing and
increase accuracy. Note: When renaming files, do not add the .xml extension if the extensions are not
showing in the filedirectory, as OSIRIS will then be unable to recognize the file.

If the user wants the new OP to have a different name to distinguish it from the old OP, it can be renamed in
OSIRIS by selecting Tools>Lab Settings, picking the OP with the old name in the list, and selecting the
“Rename” button then entering the new name desired. Alternatively, the name can be edited in the XML of
the lab settings file by opening the filein Notepad. Finding the <VolumeName>0ld OP Name</VolumeName>
and changing Old OP Name to New OP Name. Do not change anything else as it may corrupt the file. Note: If
both the old OP and new OP names are left the same, OSIRIS will only display one of them in the pick list,
leading to confusion and possible errors.

If the user wants the old OP to appear in the picklist, in the old OP directory, remove the “BAK” from the old
OP file name.
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( Pdatiﬂg OF% with a batch file

The batch file described below will update all custom OPs (in the Windows version) by copying the new message book
from the default Identifiler OP into the custom OPs. (Note that the message book is not kit-specific.) Change the path
name specified by OSTOP to point to the OSIRIS installation directory. Four directory path examples are given, three
of which start with “rem”.

The file:

cpmsg.bat

@echo off

rem ***3 of the following 4 lines giving the install dir path should begin with 'rem'
set OSTOP=C: \Users\myusername\Downloads\Osiris

rem set OSTOP=V:\

rem set OSTOP=\\labfileserver\Osiris Program

rem set OSTOP=C:\Users\myusername\Documents\Osiris

set MSGBOOK=MessageBookV4.0.xml

set SRC=%0STOP%\Config\Volumes\ID\ID $%MSGBOOK%
set DEST=%0STOP%\site\Volumes

set VOL=%0STOP%\site\Volumes

for /d %%i in ( "SDEST%\V-22??2222?2-22?2222" ) do call :DOCOPY "%%i"
GOTO END

: DOCOPY

copy "$SRC%" %$1\%~nl $MSGBOOK%
if ERRORLEVEL 1 GOTO ERROR
GOTO END

:ERROR
pause

:END

APPcndix C. SamPlc Rework

OSIRIS predicts and recommends sample reanalysis that would improve the quality of DNA profiles that have
artifacts. The user can override these recommendations during editing, allowing the user to determine which, ifany,
rework is preferred for any individual sample or for an entire run. The user-selectable rework options are listed in
the Artifact List (See Appendix F.)in the Sample and Directory categories. All of the rework options in the Directory
category are user-selected; OSIRIS does not recommend rework for entire batches. Both software-recommended and
user-selected rework options can be exported to either a LIMS or to a manual listto aid in sample re-queuing.

The following describes the logic underlying OSIRIS sample rework recommendations.

There are a number of OSIRIS-recommended rework options for individual samples incorporated into the
MessageBook (version 4.0). These are: Recommend Reamp Less, More, Regular (or Reinject) and Recommend Reamp
With Human Review. The latter does not export to the LIMS.

The software’s decision between reamp negative and reamp positive depends in part on whether any peak in the
sample exceeds a user-specified threshold we call the overload limit. Neither the reamp negative nor the reamp
positive recommendation is made for samples that are actually ladders. The reamp regular recommendation applies
to ladders whose ILS fails.
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Reamp negative
The computation that a reamp negative should be recommended is made if (except for ladders):

e [The sample has had at least one locus drop out -that is, no alleles were found for at least one locus AND there
is at least one allele in the sample which exceeds the overload limitthreshold]...OR

o The sample has excessive pull-up -user-specified threshold AND at least one sample allele has height above the
overload limit...OR

e The sample has an excessive number of craters -user-specified threshold...OR

e  Atleast one sample peak has been measured to have laser off-scale -when preset is configured to use this

information.

Reamp positive
The computation that a reamp positive should be recommended is made if (except for ladders):
e [The sample has had at least one locus drop out that is, no alleles were found for at least one locus AND there
no alleles in the sample which exceed the overload limit threshold] OR At least one locus is under-amped -
see below...AND

e The sample is not a ladder.

The computation of the reamp positive recommendation depends on whether or not At least one locus is under-
amped. Thisoccurs if:

e [One or more loci has peaks between analysis and detection thresholds AND EITHER (no genotype was found
for that locus OR the locus is homozygous with a peak that is below an acceptable threshold) OR (locus has
peaks below the analysis threshold that are not known artifacts -e.g., stutter- AND the locus is
homozygous)]...OR

e [The “amplify more on homozygote problem” preset is specified AND (no genotype was found OR there was a
problem with the height of a homozygote)]...AND

e The sample is not a negative control.

Reamp ambiguous
In case both recommend reamp positive and negative are true, neither are reported. Rather, a “reamp ambiguous” is
reported and human review is required.

Reamp regular/Reinject

The computation that a reamp regular should be recommended is made if:
e The sample contains “too many” excessive residuals-user-specified threshold...OR
o The percent of excessive residuals is too large user-specified threshold...OR

e  The ILS analysis failed.

Reamp regular is only reported if neither reamp positive nor reamp negative istrue. Reinjection is recommended
instead of reamp regular based on the user selection in the lab settings.

During edit mode, the user can override any of these recommendations by selecting from the list of alternative rework
commands. OSIRIS will allow the selection of only one of the rework commands for any given sample. The user can
also choose to select a single rework command to apply to the entire plate.

APpcndix D. Quality A\ssurance and Automation (Ises

Custom reports from OSIRIS can be scripted by the user, giving flexibility that allows a wide variety of different quality
information to be exported in abroad array of formats. (See Appendix E.) These reports can be configured to export
automatically upon analysis of a folder. This makes it possible to automate OSIRIS information collection for
assessment of not only sample quality, but also process quality. See the discussionof the Sample Threshold settings
for descriptions of Sample QC versus Process QA parameters. Typically, the process QA parameters target batch
issues or the severity of sample quality issues, rather than individual sample artifacts. Please contact the OSIRIS team
with suggestions about additional parameters you feel would be useful in this program (forensics@ncbi.nlm.nih.gov).
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OSIRIS can also export samples from one analysis file into another, allowing discovery or sorting samples into
good/artifactual analysis files. The following are examples of ways that OSIRIS could be used with custom user-
scripted exports (example #3 has already been accomplished):

1 Automate real-time checking of control samples in a high throughput laboratory.
Example: A laboratory running multiple plates per day wants to analyze the controls as each capillary
electrophoresis run is completed, both so that process problems can be identified before too many samples
are in the pipeline, and to allow early re-queue of samples needing rework, reducing turnaround of problem
plates and speeding up completion of high priority samples. To address this, the lab configures OSIRIS to
analyze one or more batches and automatically export a file with notifications of control sample artifacts
without requiring an analyst to review all controls. The artifactual controls can then be evaluated to
determine the issue so that there can be early intervention to rectify the problem.

2 Accelerate acceptance and export of high quality samples.
Example: A convicted offender testing laboratory wants to speed up the acceptance and export to LIMS of high
quality samples without issues. After validation of OSIRIS as an expert system, the laboratory configures
OSIRIS to analyze and automatically export the controls and all high quality samples without issues for
import to the LIMS system without need for analyst review. A second automatic export is configured to
export all samples requiring attention to a new project file for analyst review.

3 Automate selection of the better of two injections
Example: A convicted offender testing laboratory does not quantitate template DNA before amplification and
wants to automate selection between the better of 5 and 10 second injections. The laboratory configures an
export to select the better of the two injections and report which samples failed both injections. The
laboratory analyzes with OSIRIS, runs the export to select and export the successful injections, then an
analyst reviews samples without a successful injection.

4 Automate sample reanalysis.
Example: A laboratory wants to automate reanalysis of samples that gave poor quality profiles, to reduce
turnaround time. The laboratory configures OSIRIS to analyze and automatically export sample rework
recommendations either to LIMS or to a manual list for re-queuing.

5 Monitor Color Matrix performance.
Example: A laboratory wants to monitor color matrix performance to detect performance degradation before
significant numbers of samples require rework. The laboratory configures OSIRIS to automatically export a
QA report of samples with pull-up and saturated data (laser off scale) artifacts. The laboratory imports this
report into LIMS or a control chart spreadsheet to monitor the proportion of pull-up artifacts to saturated
data artifacts to determine when the matrix performance begins to degrade, before a significant change is
noted by the analysts.

6 Monitor capillary/array performance.
Example: A laboratory wants to monitor capillary performance in their capillary arrays to maximize array
value and minimize sample reanalysis. The laboratory configures OSIRIS to analyze and automatically export
a QA report giving each capillary’s peak morphology quality data (peak fit). The laboratory imports this into
LIMS or a control chart spreadsheet to monitor changes in peak fitto discover impending capillary failure.

7 Monitor Sample /extraction quality.
Example: A convicted offender laboratory wants to monitor the quality of submitted samples and the DNA
extraction. The laboratory configures OSIRIS to analyze and automatically export a QA report of artifact data
regarding samples with too little, too much, and degraded/inhibited DNA to monitor sample/extraction
quality.

8 Monitor Contamination.
Example: A laboratory wants to automate continuous contamination monitoring. The laboratory configures
OSIRIS to analyze and automatically export a QA report of contaminated negative controls and negative
controls with peaks that are above the detection threshold but below the analysis threshold, to monitor both
obvious contamination and sub-analytical contamination.
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APPcndix E_ Uscr Dcwcincd }:ilc E_xport

OSIRIS provides the ability to customize exporting of data from an analysis file to any text or xml format. This allows
users to create exports for their laboratory’s unique needs. Examples of customized exports include files in a format
that can be imported into the laboratory’s LIMS system or into specialized spreadsheet applications, files formatted
for upload into CODIS (“Export CMF file..” onthe File menu), files formatted for a user-designed display,
OSIRIS analysis report files which can be viewed in OSIRIS containing the samples pertaining to a particular case for
discovery (included with OSIRIS), and text files or tables for inclusion in a report. Since the information that can be
included in an export is only limited by the information in the analysis file itself, exports can be designed with a wide
variety of user applications including automation, process control, reporting, and any other uses that may arise.
Contact the OSIRIS team with questions and suggestions regarding scripting custom exports
(forensics@ncbi.nlm.nih.gov).

OSIRIS exports data from an analysis file using the XML Style Language Transforms (XSL, XSLT) version 1.0. This is
implemented with the libxslt open source library from the GNOME project and includes the exslt extensions. The

actual XSLT language syntax is beyond the scope of this document but is documented in many books and web sites;
however no technical expertise is required to implement the use of an existing XSL file. A tutorial for
implementing two export file types supplied with OSIRIS can be found in the Export Setup Tutorial.

The input XML for the XSL transform is the analysis file, whether itisan .oar or .oer file. The format of the analysis
file is described in the XML schema file, OsirisAnalysisReport-2.0.xsd. This file can be found in the
Config\xsd subdirectory inthe OSIRIS installation directory in the Microsoft Windows ™ version of OSIRIS and in
the Contents/Mac0S/Config/xsd subdirectory of Osiris.app onthe Macintosh ™,

The XSL file can have top level parameters (using the <xs1:param> tag) which can be configured in OSIRIS to
provide a user interface to set these parameters. Two <param> names are reserved, they are inputFile and
outputFile, whichif implemented are automatically set to the full path of the analysis and exported file names,
respectively.

The XSL tag, <xs1:message> can be used to notify the user when there isa problem. The output produced by these
tags is displayed ifthere is a failure in the export or if there is no output at all. Also, whether or not the export fails,
the output isalso logged and can be viewed in the message log which is the lastitem in the “Tools” menu on the
menu bar.

To create, modify, or delete an XSLT export file type, select “Export File Settings”from the “Tools” menu on
the menu bar. A window will appear with alist of all configured export filetypes or text stating that none exist. From
here, the user can select “New...” to create a new file type or select one from the list and then select “Edit..” or

“Remove..”

. aps . ¢ . ) . Create Export File Type
When creating or editing an export file type a ‘Wizard’ dialog i ® =
. . . . X5L File
window is used to configure an XSLT export type. The first F—
panel is shown on the right. The needed information is as Export e description
follows:
File name extensions
Export File Description. This istext displayed in the P
File menu or the Export submenu in the file menu for this Defeult output fie location
export type. If there is one export type defined, it will appear fsame as Anlyss el ™ ey

after the word “Export” in the file menu. If two or more are
defined, there will be an “Export” submenu in the file menu
listing all of the export types.

File Name Extensions. Thisisacomma separated listof

file name extensions of the output files to be saved. Some < Back Next > Cancel
examples are: txt, xml, tab, csv. The checkbox labeled

“Allow user to override”isused to allow these selections to be overridden when saving a file.

Default Output File Location. Thisisthe folder that will serve as the default when exporting a file. This

can be a specific folder which can be navigated by clicking on the browse button or one of two predefined values. One
predefined value is“[Same as Analysis File]” which will use the location of the analysis file used for input as
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the default location. Another predefined valueis “[Remember Last Location].” Ifthis option is used, the
location where the last exported file was saved will serve as the default next time a fileis exported.

XSL File. This isthe full path of the XSL file used in the transform.

Once these parameters are entered, select the “Next >" button to proceed to the next panel shown below:

TR T == | This panel allows configuration of all of the top-level parameters
Bier eEEs e (<xsl:param> tags) in the XSL file, ifany, except for the two
rameny reserved parameters, inputFile and outputFile, which are
Prmeser P described at the beginning of this section. Each parameter is
mt=ger given and a description and type. The Parameter
o et description isthe label used in a dialog when exporting a file.
checkbox

ianore The Parameter type isone of: text,integer,decimal,
choice, choice/text,or ignore. If ignore isselected, then
this parameter will notbe set when exporting data. If textis
selected, then the user will be able to enter any text when
exporting. If integer or decimal are selected, the panel then
allows a valid numeric range. When the user exports data, a
(o [ tts ] [ cond ] number can be entered which isvalidated and not be accepted if it
isout of range. The choice type displays a multi-line text box
that allows alist strings values to be entered. When the file is exported, the user can choose one the strings from a
drop down listto be passed as the parameter. The choice/text option islike the choice option except the user
can optionally type a value for the parameter that is not in the drop down list. Upon exporting data, when the dialog
window for the entry of parameters appears, each is set to its default value as extracted from the XSLT file.

After configuring the parameters, the “Next >” button will go to the third and last panel. This panel is used for
configuring an automated export after each analysis. This is Create Export File Type =)
illustrated on the right. If the checkbox at the top is selected, T

then an attempt to export the file is performed after each Location Bronse...
analysis. There is, however, one caveat. If the Operating
Procedure used in the analysis does not allow automated export
when the analysis results need attention due to critical
messages, the export is not performed. Three other parameters
are used when an automated export isused. The first one is the
Location of the output file. The user can select“[Same as
Analysis File]”orthe Default Output File
Location entered in the first panel ifitis a directory.
Otherwise the user can enter the full path of an existing
directory and/or use the browse button to search for one. The
“File name” is the name of the file to be saved, not including the
file name extension, or can be set to “[Same as Analysis
File]” from the dropdown list. If the checkbox below is checked, the date and local time will be appended to the file
name in order to ensure that no existing file is overwritten. The File extension can beselected from the
dropdown listwhich contains all file extensions entered in the first panel or the user can enter a new file extension.
Please note that when performing an automated export with this option, all of the top level parameters are not set by
OSIRIS and therefore use their default values. Once this is completed clicking on the “Finish” button will save the
export type and close the dialog window, returning the user to the “Export File Types” window, which can be
closed by clicking on the “Done” button. All changes should be immediately reflected in the “File” menu on the
menu bar when viewing an analysis file.

File name
Append date to file name

File extension

| < Back H Finish ]| Cancel |
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APPcndix }: Artifact Li st

The following is a list of artifacts that OSIRIS tests, whether or not the artifacts are Critical or Non-Critical, whether
they export when performing an export to LIMS, and their priority. Critical artifacts display a user notification and
require user intervention. Non-critical artifacts can be displayed in either of the graphical views and information
about them is available through the hover box, but they do not produce user notifications and do not require user

intervention.

(Note: X = critical; * = whether critical computed at run time; * = whether to display computed at run time; E = LIMS
export; Priority = selection level for LIMS export when there are multiple export artifact options)

Artifact

Signals:
Pull-up at Extraneous ILS Peak

Curve Fit Unacceptable

Laser Off Scale [Pull-up also called]

Laser Off Scale: Probably Primary Pull-up

Laser Off Scale: Peak May Be Result of Pull-up
Curve Fit Marginal

Spike

Blob

Pull-up

Primary Pullup

Peak [s a Possible Unreported OL Allele

BELOW MINIMUM ANALYSIS RFU

Unexpected Peak in ILS

Peak Height Above Maximum Threshold

Conflict Osiris Below Min RFU; Raw Data Above
Conflict: Raw Data Below Min RFU; Osiris Above
Conflict: Osiris Above Max RFU; Raw Data Below
Conflict: Raw Data Above Max RFU; Osiris Below
Stutter

Peak to Right of ILS

Adenylation

Inter-locus Ladder Peak

Unexpected Peak in Ladder Locus

Width Unexpectedly High or Low

Crater or Poor Morphology: Possible Critical Adenylation
Signal Height Below Minimum Fractional Filter Height
Signal Height Below Minimum Pullup Fractional Filter Height

Below Fractional Filter (Left)

Below Fractional Filter (Right)

Below Pullup Fractional Filter (Left)
Below Pullup Fractional Filter (Right)
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Artifact

Signal Is an Inter-Locus Pull-up

Signal Is an Inter-Locus Pull-up with Poor Fit
Unassigned Inter-Locus Peak

Ambiguous Inter-Locus Allele (Left and Right)
Identity As Interlocus Crater Ambiguous

Possible Ambiguous Interlocus Peak Assigned to Locus
Peak Height Below Min Interlocus RFU

Possible Crater

Possible Crater Side Peak

Possible Valid Off-Ladder Inter-Locus Allele (Left)
Possible Valid Off-Ladder Inter-Locus Allele (Right)
This Peak Has Restricted Priority

Initially Considered As A Possible Crater

Initially Considered As A Possible Crater Side Peak
Possible Pull-up Coincides With Allele

Extraneous Peak for Positive Control

Base Pair Residual Exceeds Threshold

Pullup with Excess Residual in Multi-allele

Possible Extra-Ladder Allele [peak is stutter or adenylation
to interlocus peak that may represent an allele]

Extraneous Peak Within AMEL Locus
Peak Exceeds Injection Overload Threshold
Unexpected Peak in Negative Control
ILS Peak May Be Incorrect: Too Short

Locus:

Locus Has Peaks Between Detection and Analysis Thresholds
Locus Has Peak(s) with Laser Off-Scale

One or More Peaks Above Maximum Threshold
Locus Contains Too Few Peaks [Ladder]

Poor Locus Morphology [Ladder Locus Spacing]
Locus May Have Unreported Off-Ladder Alleles
Setup Error: Number of Peaks Unavailable for Locus
Relative Height Imbalance [Control Peaks]

AMEL [s Misaligned [not used yet]

X Allele for AMELOGENIN Could Not Be Found

Locus Contains Crater(s)

Positive Control Locus Mismatch

No Genotype Was Identified

Unexpected Peaks in Neg Ctrl Locus

Unexpected Number of Peaks [Ladder]

Heterozygous Imbalance Detected
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Artifact

Heterozygous Imbalance May Be Result of Pullup At Allele(s)
Single Peak Detected, Height Inappropriate for Homozygote
Locus Contains Peaks with Excessive Residuals

AMEL Contains One or More Extraneous Peaks

One or More Interlocus Peaks to Right of Locus

One or More Interlocus Peaks to Left of Locus

Associated Ladder Locus Has Critical Artifact(s)

Three Alleles Were Identified

More Than Three Alleles Were Identified

Off Ladder Allele(s) Detected

Critical Level Messages At Allele(s)

Unexpected Peak(s) in Sample Locus

This Locus May Be Under-Amped

Channel:

Lane Standard Requires Analyst Review: Spacing Is Marginal
Channel Has Raised Baseline

Channel Has Excessive Noise Above Analysis Threshold
Channel Has Excessive Noise Above Detection Threshold
Channel Has Excessive Noise: Peaks May Be Unreported
ILS Spacing Does Not Meet Expected Parameters

ILS Contains Too Few Peaks

Unable to Read FSA Channel

Cannot Separate ILS Primer Peaks

ILS Neighbor Filters Remove Too Many Peaks

ILS Fractional Height Filter Removes Too Many Peaks
ILS Relative Heights Inconsistent with Expected Heights
Unexpected Peaks in Channel [Negative Control]
Positive Control Locus Not Found in Set

Critical Level Messages At ILS Peak(s)

Negative Control Channel Contains No Primer Peaks
Channel Peaks Have Critical Artifacts

Ambiguous Extended Locus Channel Peaks

Sample:

ILS Could Not Be Analyzed

Sample Requires Analyst Review: Marginal Lane Standard
At Least One Channel in Sample Has Raised Baseline

At Least One Channel in Sample Has Excessive Noise: Peaks
May Be Unreported

The Allelic Ladder Type Is Not Recognized
Unable to Read FSA File
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Artifact

Named Positive Control Not Found

One or More Positive Control Locus Not Found in Set

One or More Negative Control Channels Contain No Primer
Peaks

One or More Peaks Have Laser Off-Scale

Sample Has At Least One Homozygote That Is Too Short
Associated Ladder Has Critical Artifact(s)

Sample May Be a Mixture

Total Number of Homozygous Loci [Exceeds Threshold]
Total Number of Tri-allelic Loci [Exceeds Threshold]
Number of Pullups in Sample Exceeds Threshold

Number of Excessive Residuals in Sample Exceeds Threshold

Percent of Alleles with Excessive Residuals Exceeds
Threshold

Percent of Pullups Exceeds Threshold

Number of Stutter Peaks Exceeds Threshold

Number of Adenylation Peaks Exceeds Threshold
Number of Off-Ladder Alleles Exceeds Threshold
Negative Control Requires Analyst Review

Allelic Ladder Could Not Be Analyzed

Core OLAllele: Recommend Rerun Sample

Too Many Excessive Residuals: Recommend Rerun Sample
Sample Could Not Be Analyzed

Number of Crater Peaks Exceeds Threshold

Number of Spikes Exceeds Threshold

At Least One Allele Exceeds Amplification Overload Limit
Locus Dropout For At Least One Locus

Recommend Reamp Less (OSIRIS - Export)

Recommend Reamp More (OSIRIS - Export)

Recommend Reamp Regular (OSIRIS - Export)
Recommend Reinject (OSIRIS - Export)

Recommend Reamp With Human Review (No Export)

At Least One Locus May Be Under-amped

Color Correction Matrix Expected But Not Found - Using
Uncorrected Data

Color Correction Matrix Wrong Size - Using Uncorrected
Data

Reamp Sample Regular (Analyst - Export)
Reamp Sample More (Analyst - Export)
Reamp Sample Less (Analyst - Export)
Reinject Sample (Analyst - Export)
Reextract Sample - Swab (Analyst - Export)
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Display . et LIMS  LIMS

Artifact m Critical Export Priority
Conditional

Reextract Sample - Blood (Analyst - Export) E 1

Do Not Rework Sample (Analyst - Export) E

Verification Sample (Analyst - Export) E 1

Summary Locus:
Number of Sample Loci with Craters Exceeds Threshold X

>

Percent of Loci with Craters Exceeds Threshold

Directory:
No Allelic Ladder File Identified

Default Protocols Are Overridden

Reagent Kit Not Recognized

More Than One Reagent Kit Identified in Directory
Could Not Find Named Population Marker Set
Could Not Find Named Internal Lane Standard

No Positive Control Found In Directory

No Negative Control Found In Directory

Named Positive Control Not Found

KX K X X X X} X X X

Total Number of Samples with Excessive Pull-up Exceeds
Threshold

Percent of Samples with Excessive Pull-up Exceeds
Threshold

<

Re-amp All Regular
Re-amp All Less
Re-amp All More
Re-inject All

M m MM
N N NN
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APPcndixG.Addinga Ncw Kit

The easiest way to add a new kit to OSIRIS is to use an existing kit as a template and modify it to apply to the new Kkit.
If you need assistance or have questions regarding adding a new Kkit, please contact us: forensics@ncbi.nlm.nih.gov. If
you add a new kit definition to OSIRIS for a commercially available kit and would be willing to share that with the
community, please submitit to us. This allows us to check that the kit definition is robust and allows us to put the kit
definition in a future OSIRIS release, so that users will not have to re-install the kit when upgrading to a new version
of OSIRIS. A new kit that used a fragment sizingladder as alocus would allow use of OSIRIS for fragment sizing.

1. Find the files that must be modified: kitcolors.xml and ILSAndLadderInfo.xml (to locate them, go to the Osiris
directory; these files are in ..\Osiris\Config\LadderSpecifications)

New ]ntemal Lane Stan&ards (] LS’S)
a. ILSAndLadderInfo.xml:
i. Ifneeded, add the specifications for any new Internal Lane Standards (ILS’s)

ii. ILS names must be unique

iii. The characteristics are the sizes of the ILS peaks, each separated by a space

iv. Relative peak heights are High (H), Medium High (MH), Medium (M), Medium Low (ML) and
Low (L) - in the absence of expected relative height information, use either H or MH for all.

v. The Correlation Acceptance Threshold dictates the minimum correlation of spacing between
located peaks and ideal characteristics and 0.993 has worked well (that is, accepts common
spacing and rejects incorrect collections of peaks) for both ABI and Promega ILS’s

vi. Correlation Auto Acceptance Threshold dictates the minimum correlation of spacing
between (quadratically) transformed located peaks and ideal characteristics (accounting for
non-linear distribution of characteristics): 0.999 works well (see above) for Promega and
0.9975 works well for ABI (both with and without the “250” peak)

vii. Under the “kits” tag, near the bottom of the file, the new kit name must be specified, along
with the file name for the ladder specification data. For example, for Identifiler and
IdentifilerPlus:

<Set>
<KitName>Identifiler< /KitName>
<FileName>Identifiler_Lad derInfo.xml</FileName>

</Set>

<Set>
<KitName>IdentifilerPlus </KitName>
<FileName>IdentifilerPlus_LadderInfo.xml</FileName>

</Set>

viii. Back up this modified file for reinstallation in case OSIRIS needs to be re-installed or
upgraded.

Kt (olors
b. Kkitcolors.xml:
i. The new kit must be added, led by the kit name

ii. Each channel must be specified with colors for the Osiris Analyzed data (analyzed), the raw
data (raw) and the associated ladder (ladder). The precedent is that color shades are
increasingly lighter from Analyzed data>Raw data>Allelic ladder data.

iii. Generally, color data may be copied from already existing kit(s)

iv. Back up this modified file for reinstallation in case OSIRIS needs to be re-installed or
upgraded.

Osiris (Jsers (Guide Fagﬁ 59
Version2.02Rev.1


mailto:forensics@ncbi.nlm.nih.gov?subject=New%20kit%20in%20Osiris

|_adder

2. The Ladder Data File

a. The file name is the same as specified in 1.a.vii (above) and the path should be the same as the
kitcolors.xml and ILSAndLadderInfo.xml files
b. Under the tag “LS”, listall available internal lane standard names and specify the channel number of
the ILS. For example:
<Set>
<Name>IdentifilerPlus</Name>
<NChannels>5</NChannels>
<LS>
<LSName>ABI-LIZ500</LSName>
<LSName>ABI-LIZ450< /LSName>
<LSName>ABI-LIZ400</LSName>
<LSName>ABI-LIZ350</LSName>
<ChannelNo>5</ChannelNo >
</LS>
c. File name suffix, genotype suffix and directory search string are no longer used, but must be
included; any values may be used
d. Optionally, a channel map, relating the channel in the .fsa fileto the “reported” channel, can be
specified...see the XML schema and the example below:
<DirectorySearchString>PP12< /Directory Search String>
<FsaChannelMap>
<Channel>
<KitChannelNumber>1< /KitChannelNumber>
<fsaChannelNumber>1< /fsaChannelNumber>
</Channel>
<Channel>
<KitChannelNumber>2< /KitChannelNumber>
<fsaChannelNumber>3< /fsaChannelNumber>
</Channel>
<Channel>
<KitChannelNumber>3< /KitChannelNumber>
<fsaChannelNumber>4< /fsaChannelNumber>
</Channel>
</FsaChannelMap>
e. For each locus, enter:
i. Locus name
ii. Channel number
iii. MinBP: the allelic ladder base pair that gives the low end of the range of the extended locus
(may be set to be equal or less than the allelic ladder base pair of the first ladder allele).
iv. MaxBP: the allelic ladder base pair that gives the high end of the range of the extended locus
(may be set to be equal or greater than the allelicladder base pair of the last ladder allele).
v. MinBP and MaxBP can be set to overlap neighboring loci, either core or extended, but may
not exceed either neighboring core locus
vi. The lab settings parameter labeled “Ignore artifacts lower than...” must be setlow enough
that it does not impinge on any ladder or extended alleles. If not specified in the lab settings
file, this parameter defaults to ILS-ref value of the left-most ILS peak.
vii. MinGridLSBasePair: left end of the search interval for locus ladder alleles (in ladder files),
specified in ILS-ref units
viii. MaxGridLSBasePair: right end of the search interval for locusladder alleles (in ladder files),
specified in ILS-ref units
ix. The two parameters above delineate the range in which the ladder locus alleles can be found
and should be set conservatively large (for example, 20 - 30 ILS-ref units beyond
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approximate ends of ladder locus); adjacent search intervals can overlap; the values can be
integer or decimal
x. Listofladder alleles
1. Allele name (repeat number, except X and Y for AMEL, which are designated by “1”
and “2”)
2. Curve number (unused but must be present)
3. BP: allelic ladder, or sequence, base pairs
4. Relative Height: as for the ILS, above; should always be specified, even if always “H”
or “MH”
f.  Back up this modified file for reinstallation in case OSIRIS needs to be re-installed or upgraded.

Opcrating Fro cedure

3. The Operating Procedure: Standard Settings, Lab Settings, MessageBook and Access files
a. Standard settings:
i. Copy an existing standard settings file
ii. Modify standard positive control(s) to reflect new kit, where BiolD is the allele’s ladder-base
pair size*; for example:
<StdMarkerSetSpecifications>
<StdMarkerSetCollection>
<MarkerSetName>Identifiler< /MarkerSetName>
<PositiveControls>
<PositiveControl>
<Name>9947A</Name>
<Loci>
<Locus>
<Name>D8S1179</Name>
<Allele>
<Name>13</Name>
<BiolD>147</BiolD>
</Allele>
</Locus>
<Locus>
<Name>D21S11</Name>
<Allele>
<Name>30</Name>
<BiolD>210</BiolD>
</Allele>
</Locus>
<Locus>
<Name>D7S820</Name>
<Allele>
<Name>10</Name>
<BiolD>273</BiolD>
</Allele>
<Allele>
<Name>11</Name>
<BiolD>277</BiolD>
</Allele>
</Locus>

*Note that OSIRIS Version 2.0x does not use the value in the BioID tag for validating positive control alleles.

So for convenience, this may be set to zero or any other arbitrary value in the positive control definition, if
desired: <BiolD>0</BiolD>.

b. Lab Settings
i. Copy an existing lab settings file
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ii. Modify any locus specific settings and thresholds that will differ from the kit copied (e.g, the
table on the Operating Procedure Locus/ILS Thresholds tab)
iii. Modify,add orremove any custom positive control(s) from the kit that was copied
c. MessageBook
i. Copy an existing MessageBook file
d. Access file
i. Copy an existing “access.txt” file
e. Make the new Kkit's default folder
i. Rename the StdSettings, LabSettings, MessageBook, and Access files to incorporate new kit
name and place in a new folder with appropriate kit name (no spaces); add folder to
collection of the default kit folders in ..\Osiris\Config\Volumes.

Constructing a homebrew allelic ladder

OSIRIS requires an allelicladder to perform sample analysis. Therefore, if usinga custom made STR multiplex, the
user will have to construct an allelicladder to serve as a control sample. Typically allelicladders are made by pooling
individual samples to give a good representation and distribution of alleles and allele repeat sizes. Given that OSIRIS
uses a cubic spline to estimate allele sizes from the allelicladder, each locus should have at least four to five alleles at a
minimum, with as wide an allele repeat range as possible. More alleles and a wider range will increase the accuracy of
allele calling. Three or fewer alleles might not work well. The ladder allele peak heights do not need to be similar to
one another and having gaps where an allele is not present in the ladder is not a problem. In fact, the ladder fitting
algorithm is designed such that different peak height and allele gaps in the ladder actually increase the robustness of
ladder fitting. OSIRIS does not require that ladder alleles flank all of the identified alleles for allele calling. If the
sample alleles fall outside the ladder allele range, OSIRIS will extrapolate to call the alleles. In our somewhat limited
experience of OSIRIS extrapolation (using commercially available kits), OSIRIS performance calling alleles outside the
ladder range by extrapolation was excellent.

To construct an allelicladder de novo, select samples that have the alleles of interest and pool the DNA. Amplify,
analyze the pool, rebalance the amounts of the inputs to the pool to achieve the desired peak balance and reamplify
the rebalanced pool to make the ladder. Once a satisfactory ladder has been achieved, the amplified ladder can be
stored as a frozen stock for amplifying new batches of allelic ladder for analysis. Reamplification of ladder can be done
by making a 1:1000 dilution of the amplified ladder stock and amplifying 5 pl for 15 rather than 28 cycles (to avoid
over-amplification of ladder peaks). Serial amplification of ladders should be avoided to prevent degradation of ladder
characteristics or introduction of artifacts.
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APPcndix H. Troublcs]*looting and ]:AQ

Tro ub !es%ootin%
<

Problem

Solution

[ can’t upgrade my version 1.33
Operating Procedure

OSIRIS 2.02 should be compatible with viewing files analyzed with
previous OSIRIS versions 1.xx. However, for the purpose on new analysis,
version 1.xx Operating Procedures must be reentered, they cannot be
upgraded to 2.02. Version 2.0 and 2.01 Operating Procedures may be
upgraded to 2.02. See Appendix B for OP upgrade instructions.

OSIRIS crashed when I used my old
Operating Procedure

Version 2.0 Operating Procedures are not compatible and must be
upgraded to version 2.02, because version 2.02 looks for a checkbox-
setting that is not present in version 2.0 Operating Procedures. See
Appendix B for OP upgrade instructions.

[ can’t edit the Operating Procedure

You cannot edit default Operating Procedures (shown in brackets) such as
[PowerPlex 16]. Make a new Operating Procedure that can be edited.

You cannot edit Operating Procedures opened through the “Parameters”
button. These are static copies associated with the analysis file you are
viewing. Thisis designed to preserve the conditions used for a specific
analysis.

The Operating Procedure islocked while either being edited or used for
analysis by any user. Check to determine whether other users are editing
or analyzing with that OP. If you try to edit the Operating Procedure
immediately after your own analysis, it may still be locked. If you have
just performed an analysis, wait 30 to 60 seconds and try again. Locking
the OP prevents change itin the middle of analysis, or corrupting the
Operating Procedure if two users were to make changes at the same time.

If you are operating on a network or in a forensic or clinical laboratory,
your OSIRIS administrator may have limited write permissions on the
Operating Procedure directories to prevent unintended changes. Contact
your OSIRIS administrator.

You must install OSIRIS in a directory for which you have write
permission. In Windows 7, for example, if you are not logged in as the
administrator and you install OSIRIS in the \Programs directory you may
not be able to edit the Operating Procedures or create new OPs. In that
case try installing OSIRIS in a different directory (such as \My Documents
or \Downloads).

My file says that it may have been
modified outside of OSIRIS

Modification of OSIRIS analysis files (.oar, .oer, .plt) with software other
than OSIRIS will cause this message. This is designed to protect the
integrity of the data.

If the output is saved on a network drive, the time on the computer
containing that drive should be in sync within one minute of the time on
the computer running OSIRIS otherwise OSIRIS may give this message
even if the file has not been edited. It is highly recommended to
synchronize the network by using a designated computer as the time
server, possibly by using Windows Time Service on Microsoft Windows or
Network Time Protocol (NTP) on the Macintosh.

My analysis failed

Any time your analysis fails you can select the “Details” button to find
troubleshooting information. Selecting ‘View Selection” or double clicking
the failed run will open the ladder, if it could be found and partially
analyzed. In this case the ladder can be viewed in Graph View to
determine the presence of artifacts and peaks and whether the peaks are
below analytical threshold.

No ladder sample was present, or the filename did not contain the ladder
file search string. OSIRIS requires a ladder for analysis.
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Problem Solution

My analysis failed (Cont.) Artifact peaks made it impossibleto analyze the ladder ILS. Sometimes

this can be alleviated by adjusting the ILS analysis thresholds. Otherwise
re-prepare or re-inject the ladder.

The ladder’s ILS peaks are below threshold. Adjust the ILS analysis
thresholds. Otherwise re-prepare or re-inject the ladder.

The ladder’s peaks have artifacts or are below threshold. Sometimes this
can be alleviated by adjusting the Ladder analysis thresholds. Otherwise
re-prepare or re-inject the ladder.

FAQ

Can I enter a new kitin OSIRIS?
Yes. See Appendix G for instructions. Contact us for help or advice.

Can I use a different ILS?

Several different ILS are defined for various kits. Note that some of those are actually one ILS, but use more or fewer
of the peaks, in case not all peak data gets collected. If the ILS you use is not defined for the kit you use, see Appendix
G for instructions on defining a new ILS. Contact us if you need help.

What do I do if my multiplex has no ladder available?
You can either construct a ladder, or you can use a DNA sizing ladder to add a new kit. See Appendix G or contact us
for help.

How fastis OSIRIS?

OSIRIS should process 2 to 4 samples per second, depending on the number of artifacts in the samples and the speed
of your computer/network. So a plate of 98 samples with controls should take 30-60 seconds to analyze. If it runs
significantly slower than that on your system, contact us for advice.

How many samples can OSIRIS process at once?

OSIRIS will process at least 800 samples in a single batch (single directory). OSIRIS will process an essentially
unlimited number of batches in a single processing run. This has been tested with approximately 10,000 samples in
110 directories (plates) in a single analysis that took approximately 1 hour 20 minutes.

How many users can use OSIRIS at the same time?

This is limited only by the number of client computers you have and the speed of your network and server. Generally,
it should be “lots.” Additionally, each user is creating a separate instance of OSIRIS running on the local client, so
multiple users will not affect the speed of operation except as limited by sample data flow across the network to and
from the server ifthe sample data and OSIRIS output is being stored on the server. A single user can run separate
instances of OSIRIS onthe same computer at the same time, allowing different analyses or tasks to be performed
simultaneously.

Is there any fee for OSIRIS software or use?
No. OSIRIS isfree and open source.

Is OSIRIS source code available?
Yes. OSIRIS version 2.02 source code s available from the OSIRIS homepage:
http://www.ncbi.nlm.nih.gov/projects/SNP/osiris/.

Can I modify OSIRIS, build itinto my front end or incorporate itinto my own software?
OSIRIS is open source. You may do anything your little heart desires. In any work or product derived from this
material, proper attribution to the authors as the source of the software would be appreciated.

Contact us: forensics@ncbi.nlm.nih.gov.
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